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FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio or television 
reception. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures.

◗ Reorient or relocate the receiving antenna. 

◗ Increase the separation between the equipment and receiver.

◗ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

◗ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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Introduction

Your EPSON Stylus® COLOR 3000 printer is the ideal output 
device for high-quality, large format graphic and business 
communication pieces—such as color comps, checkplots, maps, 
presentations, banners, iron-on transfers, and backlit displays—
or any project you create. With resolutions up to 1440 × 720 
dpi (dots per inch), you get amazingly realistic photographic 
images, vivid color graphics, superb grayscale images, and 
razor-sharp black printing for detailed line art and crisp text.

Its large format capabilities (up to 17″ × 22″ size paper) and fast 
print speeds allow you to print full bleed, 13″ × 19,″ photo 
quality color comps with ease. And its versatile, built-in paper 
feeding options let you print on virtually any media, of almost 
any size, including single sheets, continuous fold paper, and roll 
paper. You can even load continuous paper and single sheets 
simultaneously, printing on each in turn by flipping a lever.

The printer software for Microsoft® Windows® and Apple® 
Macintosh® computers provides advanced color management, 
with adjustable levels of brightness, contrast, saturation, and ink 
colors. Support for ColorSync™ and Windows ICM ensures 
printouts that closely match the colors on your monitor. You 
can also perform many printer maintenance procedures right 
from your computer, such as cleaning and aligning the print 
heads. And EPSON’s extensive online help can guide you 
through printer operations in real time.

Note:
Also included are the 
EPSON Plot! program and 
the Autodesk Device 
Interface (ADI) plotter 
driver. EPSON Plot! 
allows you to print 
HPGL or HPGL/2 plot 
files on your printer. See 
Appendix A for details. 
The ADI driver allows you 
to print from AutoCAD 386 
releases 10 and higher. 
See the README file on 
the driver CD-ROM for 
more information.
1
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With standard parallel and high-speed serial ports and optional 
network connectivity, setting up your printer is fast and easy. 
EPSON’s specially formulated, quick-drying ink and wide 
variety of ink jet media give you the best quality output and the 
most flexibility for getting the results you want.

PC System Requirements
To use your printer in either a standalone or peer-to-peer 
network environment, your system should include these 
requirements:

◗ IBM®-compatible PC with a Pentium® 4 1 GHz or higher 
processor recommended 

◗ For parallel connection: Windows® 95, 98, Me, NT 4.0, 
2000, or XP 

For USB connection: PC with USB port running Windows 
98 Second Edition (factory installed), Me, 2000, or XP

For IEEE 1394 connection: PC with FireWire port 
running Windows 2000 or XP

For 10/100 BaseT Ethernet connection: Ethernet-equipped 
PC running Windows 95, 98, Me, NT 4.0, 2000, or XP

◗ 512MB of RAM 

◗ At least 25MB of free hard disk space to install the software, 
and at least 2GB of free hard disk space for processing files 
(8GB or more available hard disk space recommended)

◗ Quad-speed (4×) CD-ROM or DVD drive for installing 
the printer software
2
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◗ For parallel connection: a high-speed bidirectional, 
IEEE-1284 compliant parallel cable, 6 to 10 ft. (1.8 to 3 m) 
long, with a D-SUB, 25-pin, male connector for your 
computer and a 36-pin, Centronics® compatible connector 
for the printer

For IEEE 1394 (FireWire) connection: the optional IEEE 
1394 port (C823722) and a shielded IEEE 1394 cable

For network connection: the optional Ethernet card 
(C12C823912) and a compatible cable

Macintosh System Requirements 
To use your printer in either a standalone or peer-to-peer 
network environment, your Macintosh system should include 
these requirements:

◗ OS 8.5.1 through 9.X (OS 9.2.2 recommended)

◗ 500 MHz or higher processor recommended

◗ 512MB of RAM

◗ At least 25MB of free hard disk space to install the software, 
and at least 2GB of free hard disk space for processing files 
(8GB or more available hard disk space recommended)

◗ Quad-speed (4×) or faster CD-ROM or DVD drive for 
installing the printer software

◗ For IEEE 1394 (FireWire) connection: the optional IEEE 
1394 card (C823722) and a shielded IEEE 1394 cable

For network connection: the optional Ethernet card 
(C12C823912) and a compatible cable
3



Introduction

Loire-PLUS.BK.book  Page 4  Friday, May 2, 2003  2:56 PM
How To Use Your Manuals
To set up your printer and install your printer software, see the 
Quick Setup booklet. This User’s Guide contains the following 
information:

Chapter 1, “Basic Printing,” gives step-by-step instructions for 
everyday printing with Windows or Macintosh.

Chapter 2, “Custom Printing,” tells you how to print special 
projects with custom settings for print quality, special effects, 
and color management.

Chapter 3, “Printing on Special Media,” gives guidelines for 
selecting the right paper or other media for your print job and 
instructions for loading it in your printer.

Chapter 4, “Managing Print Jobs and Network Printing,” 
explains how to manage print jobs, check printer status, and set 
up your system for network printing.

Chapter 5, “Maintenance and Transportation,” gives 
instructions for replacing ink cartridges, cleaning and aligning 
the print heads, and cleaning and transporting the printer.

Chapter 6, “Troubleshooting,” provides solutions for any 
printing problems you may have.

Appendix A, “Using EPSON Plot!,” gives instructions on how 
to install and use the EPSON Plot! program to print HPGL or 
HPGL/2 plotter files.

Appendix B, “Specifications,” provides the technical details on 
your printer, ink cartridges, and EPSON media.

A Glossary and an Index are included at the end of the book.
4
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Warnings, Cautions, Notes, and Tips

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.

Where To Get Help
EPSON provides technical support and information on the 
installation, configuration, and operation of professional 
printing products through the EPSON Preferred  Protection 
Plan. Dial (888) 377-6698, 6 AM to 8 PM, Pacific Time, 
Monday through Friday. Support hours and days are subject to 
change without notice. 

Before you call, make sure you have your Unit ID number, 
which is included with the EPSON Preferred Protection Plan 
information that came with your printer. You’ll also need your 
printer serial number and proof of purchase. 

SM

If you experience 
difficulty with the 
toll-free line or your 
Unit ID number, call 
(562) 276-1305.
5
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EPSON also provides technical assistance 24 hours a day 
through the World Wide Web. You can reach EPSON Support 
at http://support.epson.com. At this site, you can download 
drivers and other files, look at product documentation, access 
troubleshooting information, and receive technical advice 
through e-mail.

You can purchase ink cartridges, paper, and accessories from 
EPSON at (800) 873-7766, or by visiting the EPSON Store at 
www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral. 

ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency.

The EPA ENERGY STAR Office Equipment program is a 
voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient 
personal computers, monitors, printers, fax machines, and 
copiers in an effort to reduce air pollution caused by power 
generation. 

Energy-saving Tips

Here are a few tips you can use to be even more energy-wise:

◗ If your monitor isn’t ENERGY STAR compliant, turn it off 
when you’re not using it.

◗ Turn off your computer, printer, and monitor each day 
when you are done using them.

◗ Use the print preview option in your software so you can 
catch errors before you print something.
6
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Important Safety Instructions
Before using your printer, read the following safety instructions 
to make sure you use the printer safely and effectively.

◗ Turn off and unplug the printer before cleaning. Clean 
with a damp cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a 
radiator or heating vent.

◗ Do not block or cover the openings in the printer’s cabinet 
or insert objects through the slots.

◗ Use only the type of power source indicated on the printer’s 
label.

◗ Connect all equipment to properly grounded power 
outlets. Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly switch 
on and off.

◗ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche 
peut être débranchée facilement.

◗ Do not let the power cord become damaged or frayed.

◗ If you use an extension cord with the printer, make sure 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total of all devices plugged into the wall 
outlet does not exceed 15 amperes.

◗ Except as specifically explained in this User’s Guide, do not 
attempt to service the printer yourself.
7
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◗ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions: 

If the power cord or plug is damaged; if liquid has entered 
the printer; if the printer has been dropped or the cabinet 
damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.

Note the following precautions when using a printer stand with 
this printer:

◗ Use a stand that can support at least 66.0 lb (30.0 kg).

◗ Never use a stand that tilts the printer. The printer should 
always be kept level.

◗ Position your cables so they do not interfere with paper 
feeding; where possible, secure them to a leg of the printer 
stand.

Even if you are familiar with other types of printers, be sure to 
read through the following list of precautions before operating 
your ink jet printer:

◗ Do not put your hand inside the printer or touch the print 
heads during printing.

◗ Under normal circumstances, ink will not come out of the 
cartridges. If it does get on your skin, wash it off with soap 
and water. If it gets in your eyes, flush them immediately 
with water.

◗ Keep ink cartridges out of the reach of children.

◗ Do not dismantle the ink cartridges or try to refill them. 
This could result in damage to the print head.

◗ Once you install an ink cartridge, do not remove the 
cartridge except to replace it with a new one. The cartridge 
may become unusable otherwise.

◗ Install the ink cartridge immediately after you remove it 
from its package. Leaving the cartridge unpacked for a long 
time before use may result in reduced print quality.
8
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◗ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

◗ Do not shake an ink cartridge; this can cause leakage.

◗ Always turn the printer off using the POperate button. 
When this button is pressed, the Operate light flashes 
briefly then goes out. Do not unplug the printer or turn off 
the power to the outlet until the Operate light is off.

◗ Before transporting the printer, make sure the print heads 
are capped in the home (far right) position and the ink 
cartridges have been removed. For more information, see 
page 5-9.
9
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1
It’s easy to print all your color and black-and-white documents 
with your EPSON Stylus COLOR 3000. First you have to set up 
your printer and install the software following the instructions 
in the Quick Setup booklet. Then read this chapter to find out 
about the following:

◗ Printing from Windows

◗ Printing from a Macintosh

◗ Using online help

◗ Using the control panel

Printing from Windows
When you want to print from your Windows application, you 
choose Print from the File menu. You can then choose which 
pages to print, the number of copies, and other options from 
your application’s Print dialog box. When you click a button in 
the Print dialog box, you can select additional settings using 
your printer software, such as whether you want to use color or 
black ink. 

The following sections tell you how to do the following:

◗ Set printer software options from Windows applications

◗ Change the default printer software settings

◗ Check your printer’s status while you print.

Basic Printing

Note:
For instructions on 
printing HPGL or 
HPGL/2 plot files, 
see Appendix A.
1-1
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Setting Printer Options from Windows 
Applications

This section describes the options you’ll need to set for all your 
everyday printouts. See Chapter 2 for information about 
advanced settings for special print jobs. 

Follow these steps to check printer settings from your word 
processor or other Windows software:

1. Choose Print or Print Setup from the File menu. 

If you choose Print, you first see your application’s Print 
dialog box containing the settings you change most often, 
including the number of copies and the pages you want 
printed.

If you choose Print Setup, you first see a list of printers to 
choose from.

2. Make sure your EPSON Stylus COLOR 3000 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button.(You may have to click a series of these 
buttons, depending on the program you’re printing with.) 
You see the printer software’s dialog box:

Note:
The settings you select 
through your Windows 
application usually apply 
only until you exit that 
application. Then the 
driver settings may return 
to the driver’s default 
values or the Windows 
default values selected as 
described on page 1-5.

For more information 
about printer settings, 
click the Help button. 
With Windows 95 and 
later versions, you can 
right-click any item on 
the screen and then click 
What’s This?

Main tab
1-2
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3. If you don’t see the dialog box shown in step 2, click the 
Main tab.

4. Make sure the Mode option is set to Automatic so the 
printer software can determine the best settings according 
to the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

5. Choose the Media Type you want to print on from the 
following list (you may need to scroll through the list). If 
you are not sure which setting to select for your media, refer 
to the table on page 3-4.

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of media you choose determines the Print Quality 
setting (resolution) you can use. 

6. Press the Media Type button on the printer’s control panel 
to select the media you loaded in the printer. This should 
match the media you selected in step 5. If your media type 
is not listed on the control panel, select Other/Media 
Selection Off.

7. Choose Color or Black ink. If you’re printing black text or 
a draft, or if you want colors to print as varying shades of 
gray, select Black for faster printing.

8. Set the slider to Quality or Speed. This lets you choose 
between high resolution printing or faster printing on the 
media you’re using. (The slider is not available for certain 
media types and may not set the highest available 
resolution.)

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media, the 
back light film, or the 
canvas cloth. For the best 
printing at any resolution, 
always use EPSON media.

Note:
The media selection on 
the control panel can be 
overridden by the Media 
Type setting you make in 
your printer driver or 
application. 

The control panel 
selection notifies you in 
case the media loaded in 
the printer does not match 
the media you selected in 
the software. You can 
turn off the notification 
function by selecting 
Other/Media Selection 
Off.
1-3
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9. Click the Paper tab and choose your paper size and feeding 
source.

The default Paper Source is Auto Sheet Feeder, for the 
paper tray at the front of your printer. (For instructions on 
printing with the other feeders, see Chapter 3.)

10. Now choose the paper size, number of copies, collation 
options, orientation, and printable area. (Your software 
application may let you control some of these settings. 
With Windows NT, there are no collation options.)

11. Click the Main tab and check the Current Settings box on 
the bottom of the menu to see if the other settings are 
correct for your document. If you need to adjust them, use 
Advanced mode as described in Chapter 2.

12. Click OK when you’re finished checking your settings. The 
dialog box closes.

13. In your application’s printing dialog box, click Close, OK, 
or Print. (You may need to click a series of these buttons, 
depending on the program you’re printing with.)

Click to select 
your paper size

Click to select 
your paper source

Note:
Whenever you change the 
Paper Source, Paper Size, 
or Orientation settings, 
check the printer 
illustration in the dialog 
box to see how your 
document will print. 

If you load your paper 
long edge first, select a 
landscape paper size, such 
as Letter (Landscape), and 
then select your print 
orientation so the printer 
knows which way you 
loaded the paper. 

Keep in mind that some 
software may have paper 
size and orientation 
settings that override your 
printer software settings.

To cancel your changes 
and exit the driver, click 
the Cancel button at the 
bottom of the menu at 
any time.
1-4
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While you’re printing, the EPSON Despooler dialog box 
appears, showing the printing progress and the status of your 
printer. (With Windows NT, you don’t see the Despooler.) See 
“Checking Printer Status” on page 1-7 for more information.

Setting Default Printer Options

When you change printer settings through your Windows 
application (as described above), the settings apply only to the 
application you’re using. If you want to adjust the default 
settings for all your Windows applications, you can access the 
printer software through the Printer Properties or the Control 
Panel.

Make sure all your software applications are closed before you 
start. If not, you’ll have to close and then reopen them to have 
the new default settings take effect.

Setting Default Options in Windows 95 and 
Later

1. Do one of the following:

◗ Windows XP: Click Start, Control Panel, Printers 
and Other Hardware, Printers and Faxes.

◗ Windows 2000, Me, 98, and 95: Click Start, 
Settings, Printers. 

2. Right-click the EPSON Stylus COLOR 3000 icon. 

3. Select Properties (Windows Me, 98, or 95) or Printing 
Preferences (Windows XP or 2000). Then click the Main 
tab. You see the Main printer settings dialog box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Note:
Some application settings 
override printer software 
settings (such as Paper 
Size or Orientation), so 
it is a good idea to check 
the settings in your 
application before you 
print.
1-5
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Setting Default Options in Windows 3.1 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 3000 from the list of printers 
and click Setup. You see the Main printer settings dialog 
box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents.

Setting Default Options in Windows NT 4.0

1. Click Start, point to Settings, and then point to Printers. 

2. Click the EPSON Stylus COLOR 3000 icon.

3. Open the File menu and select Document Defaults. You 
see the Main printer settings dialog box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Note:
You can access the 
default Windows NT 
printer software settings 
only if you have the 
appropriate network 
access privileges, such 
as Administrator or 
Power User.
1-6
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Checking Printer Status

While your document is printing, the EPSON Despooler dialog 
box appears on your screen. (With Windows NT, you don’t see 
the Despooler. See the following section for more information.)

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper, for example, the 
Despooler warns you. You can use the buttons to cancel, pause, 
or restart your print job, if necessary. When the print job is 
finished, the Despooler dialog box disappears. 

If you don’t want the 
Despooler dialog box to 
appear each time you 
print, you can turn it off. 
To do this, start Spool 
Manager (from the 
EPSON folder), open the 
View menu, and select 
Show Despool Popup; the 
checkmark next to the 
option disappears.

The name of 
the file you’re 
printing appears 
here

Click to 
pause printing

Click to cancel 
printing

Click to 
restart printing

Status Monitor 
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The following status information also appears:

◗ Media Check
A check in the Perform Media Check before printing box 
means this function is selected (the default setting). The 
Media Check function automatically compares the media 
selected with the printer control panel with the media 
selected in the printer driver and alerts you if they don’t 
match. To turn off this function, click the box; the 
checkmark disappears. 

◗ Paper Status
The Paper Status box displays information about the paper 
loaded in the printer. You select the paper feed path in the 
driver, and the Status Monitor checks the printer for the 
size, type, and amount. The paper size and amount is 
determined by the printer. The media type is defined 
by the Media Type setting you make with the printer’s 
control panel.

◗ Ink Status
The Ink Status box displays the amount of remaining ink 
for each color.

Checking Printer Status with Windows NT

With Windows NT 4.0 servers and workstations, the messenger 
service alerts you to printer errors or lets you know when a print 
job is finished. If you have appropriate network access privileges 
or if you’re controlling printing from the server, you can also 
cancel, pause, or restart print jobs and set the sharing, security, 
scheduling, and port options. See your Windows NT 4.0 
documentation for details.

Note:
If you are using Windows 
98 or Me and connecting 
to the printer through 
your USB port or through 
a network, you will not 
see the status 
information.
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Printing from a Macintosh
When you print with a Macintosh, you need to check the 
printer software settings for each application you use. This 
section describes the settings you’ll need to choose for all your 
everyday printouts. See Chapter 2 for information about 
advanced settings for special print jobs. 

1. Start the application you want to print from and create a 
document.

2. Choose Page Setup from the File menu. You see the Page 
Setup dialog box:

3. First choose your paper feeding source. The default Paper 
Source is Auto Sheet Feeder, for the paper tray at the 
front of your printer. (For instructions on printing with the 
other feeders, see Chapter 3.)

4. After selecting your paper source, choose the paper size, 
orientation, reduction or enlargement, and printable area. 
(Your software application may let you control some of 
these settings.)

5. Click OK to close the Page Setup dialog box and continue.

Click to select your 
paper source

Click to select 
your paper size

Note:
To cancel your changes 
and exit the driver, click 
the Cancel button at any 
time.
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6. Choose Print from the File menu or click the print icon in 
your application. You see a dialog box like the following:

7. Choose the number of copies and indicate which pages you 
want to print.

8. Make sure the Mode option is set to Automatic so the 
printer software can determine the best settings according 
to the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

9. Choose the Media Type you want to print on from the 
following list. If you are not sure which setting to select, 
refer to the table on page 3-4.

◗ Plain Paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet TransparenciesI

The type of media you choose determines the Print Quality 
setting (resolution) you can use. 

Note:
Whenever you change 
the Paper Source, Paper 
Size, or Orientation 
settings, check the 
printer illustration in the 
dialog box to see how 
your document will print. 

If you load your paper 
long edge first, select 
a landscape paper 
size, such as Letter 
(Landscape), and 
then select your print 
orientation so the printer 
knows which way you 
loaded the paper. 

Keep in mind that some 
software may have paper 
size and orientation 
settings that override 
your printer software 
settings.

Click for more information 
about printer settings

Click to select your media type

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media. For 
the best printing at any 
resolution, always use 
EPSON media.
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10. Press the Media Type button on the printer’s control panel 
to select the media you loaded in the printer and selected in 
step 9. If your media type is not listed on the control panel, 
select Other/Media Selection Off.

11. Choose Color or Black ink. If you are printing black text 
or a draft, or if you want colors to print as varying shades of 
gray, choose Black for faster printing.

12. Set the slider to Quality or Speed. This lets you choose 
between high resolution printing or faster printing on the 
media you’re using. (The slider is not available for certain 
media types and may not set the highest available printer 
resolution.)

Once you’ve changed these basic settings, check the 
Current Settings box on the right side of the menu to see if 
the other settings are correct for your document. If you 
need to adjust them, use Advanced mode as described in 
Chapter 2.

13. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. See “Using EPSON Monitor3” in Chapter 4.

Using Online Help
For complete information about using the printer software, you 
can easily access online help any time. It provides detailed 
descriptions of the different settings and options.

Accessing Help from Windows Applications

To access online help from your application, open the File 
menu and choose Print or Print Setup. Then click Printer, 
Setup, Options, or Properties; you may need to click a series 
of these buttons, depending on the software you’re using. Click 

Note:
The media selection on 
the control panel can be 
overridden by the Media 
Type setting you make in 
your printer driver or 
application. 

The control panel 
selection is a reminder 
to notify you in case the 
media loaded in the 
printer does not match 
the media you selected in 
the software. You can 
turn off the notification 
function by selecting 
Other/Media Selection 
Off.

Printer settings are saved 
with your document, but 
you can’t save them from 
one application to another. 
You’ll have to check your 
settings each time you 
print from a new 
application. If you want 
to reuse settings, you 
can create document 
templates for your favorite 
applications.
1-11



Basic Printing

Loire-PLUS.BK.book  Page 12  Friday, May 2, 2003  2:56 PM
the Help button at the bottom of the dialog box for help related 
to the items on that dialog box. Then select a help topic. You 
can also access online help when you’re not using the software, 
as described below.

Accessing Help from Windows 95 and Later

Click the Start button, point to Programs, (or All Programs) 
and Epson (or Epson Printers), and then click EPSON Stylus 
COLOR 3000 Help. If you need instructions for how to use 
help, read the online “Quick Guide to Using Help.”

Accessing Help from Windows 3.1

To access online help from Program Manager, open the EPSON 
program group and click the EPSON Stylus COLOR 3000 Help 
icon. If you need instructions for how to use help, read the 
online “Quick Guide to Using Help.”

Accessing Help from Windows NT 4.0

Click the My Computer icon, then click the Printers icon. 
Right-click the EPSON Stylus COLOR 3000 icon and select 
Document Defaults from the menu. In the printer software 
dialog box, click the Help button. If you need instructions for 
how to use help, read the online “Quick Guide to Using Help.”

Accessing Help from Macintosh Applications

Choose Print from the File menu or click the print icon in your 
application. Click the Help button for help related to the items 
on that menu. To exit Help, click the OK button at the bottom 
of the Help screen.

With Windows 95 and 
later you can get specific 
help related to any item in 
the menus by 
right-clicking the item and 
then clicking the What’s 
This? prompt.

With Windows NT, you 
can get specific help 
related to any item in the 
menus by right-clicking 
the item and then clicking 
the What’s This? prompt.
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Using the Control Panel

Lights

The lights on your printer’s control panel show the printer’s 
status and alert you to problems, such as paper jams or low ink. 

Operate light

Paper Out light

Ink Out 
lights

Media Type selection lights

Pause light

Operate The Operate light is on when the printer is on. When the 
Operate light flashes, the printer is receiving data. It may 
also flash with other lights during certain operations or 
error conditions.

Paper Out S When the Paper Out light comes on, your paper ran out 
or is loaded incorrectly, or the paper-release lever is set to 
the wrong position. Load paper, check the lever position 
(see Chapter 3), and then press the Pause or Load/Eject 
button to turn off the light. 

When the Paper Out light flashes, you have a paper jam. 
Turn off the printer, gently pull out all jammed paper, 
reload the paper, and reload the paper. See Chapter 6 for 
more information.
1-13



Basic Printing

Loire-PLUS.BK.book  Page 14  Friday, May 2, 2003  2:56 PM
Ink Out BYellow

BMagenta

BCyan

BBlack

When an Ink Out light flashes, your ink supply is low. 
Make sure you have a replacement cartridge.

When an Ink Out light comes on, you need to replace the 
ink cartridge. See Chapter 5 for instructions.

Pause When the Pause light is on, printing is paused. Press the 
Pause button to resume.

When the Pause light flashes, your printer is charging 
ink, cleaning the print heads, or performing another 
operation. See Chapter 5 for details.

Plain Paper
360 DPI Ink Jet Paper

Photo Quality Ink Jet Paper
Photo Quality Glossy Film

Ink Jet Transparencies
Other/Media Selection Off

The Media Type light indicates which media you selected 
with the Media Type button. When you print, the printer 
software checks the software setting and this selection to 
see if they match. If they do not match, an error message 
appears on your screen. If you do not want to use this 
feature, select Other/Media Selection Off.

Note:
The Media Type setting only works when 
printing from the paper tray with 
Windows 95 or later, or Macintosh

If paper is loaded and the Media Type lights flash, the 
paper-release lever is not in the correct position. Match the 
paper-release lever position with the media type and paper 
source you are using.

All the lights When all the lights flash, your printer may have an 
internal error. See Chapter 6 for more information. 
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Buttons

Operate P Turns the printer on and off.

LF/FF Feeds paper line by line. Loads a single sheet or advances 
continuous or banner paper to the next top-of-form position 
if held down.

Load/Eject When paper is not loaded, loads a sheet of paper or a single 
sheet of continuous paper. 

When paper is loaded, ejects a sheet of paper. Feeds 
continuous (tractor-fed) paper backward to the paper-park 
position. Ejects banner paper backward. Feeds continuous or 
banner paper to the tear-off position when pressed after 
printing and Auto tear-off mode is set to off in default-setting 
mode. 

Pause/Reset Stops printing temporarily. Resumes printing when pressed 
again.

Clears the printer buffer if pressed for five seconds.

Micro Adjust D

Micro Adjust U

Adjusts the loading position or tear-off position for 
continuous paper. Press the Micro Adjust D button to feed 
paper forward or press Micro Adjust U to feed paper 
backward.

Micro Adjust settings are saved in the printer’s memory. See 
“Using the Micro Adjust Buttons” on page 3-20 for details 
on adjusting the loading position or tear-off position.

Cleaning  B Starts the black print head cleaning cycle if pressed for 
three seconds. See “Cleaning the Print Heads” on page 5-1.

Cleaning  A Starts the color print head cleaning cycle if pressed for 
three seconds. See “Cleaning the Print Heads” on page 5-1.

Media Type Determines whether the Media Type setting you selected in 
the printer driver matches the type of media loaded in the 
printer. 

Note:
The Media Type setting only works when 
printing from the paper tray.
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2
When you want to print presentation graphics, photographs, or 
other special projects, you can use the custom settings in your 
EPSON Stylus COLOR 3000 software. You can choose 
predefined settings or adjust individual options like brightness, 
contrast, saturation, and halftoning. For professional-quality 
color accuracy, you can use Image Color Matching (ICM) with 
Windows or ColorSync with the Macintosh.

This chapter includes the following information:

◗ Using predefined advanced settings

◗ Customizing print quality and special effects

◗ Customizing color settings

◗ Using ColorSync on the Macintosh

◗ Saving custom settings

Using Predefined Advanced 
Settings
Predefined settings provide an easy way to fine-tune your 
printer’s operation for special projects. Follow these steps to 
print with predefined settings:

1. Create your document, image, or project in your 
application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-9 (Macintosh).

Custom Printing

Note:
For instructions on 
printing HPGL or HPGL/2 
plot files, see Appendix A.
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You see one of the following dialog boxes:

Note:
When you use 
Advanced settings, the 
Quality/Speed slider 
disappears.

Click Advanced, then click here 
to see a list of project types

Windows

Macintosh

Click Advanced, then click here 
to see a list of project types
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3. Select Color or Black Ink.

4. Click Advanced, and then Custom Settings. You see a 
list of project types.

5. Follow these guidelines to choose the right setting for your 
project:

◗ Photo
For printing scanned photographs. Increases contrast 
in the image.

◗ Text/Graph
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ Video/Digital Camera (not available for 
Windows NT)
For images captured from a digital camera or video. 
Increases color brightness and makes the image sharper.

◗ Economy
For rough drafts of text only, on plain paper. Saves ink. 

◗ ICM (Windows only)
Automatically adjusts printout colors to closely match 
the colors on your screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match 
the colors on your screen. For more information, see 
page 2-10.

6. Choose the Media Type you want to print on. (If you are 
not sure which setting to select, refer to the table on 
page 3-4.) The available media are limited by the project 
you choose.

7. Use the Media Type button on the printer’s control panel 
to select the media you loaded in the printer and selected in 
step 6. If your media type is not listed on the control panel, 
select Other/Media Selection Off.

Note:
Always choose your Ink 
setting before you select a 
project setting from the 
Customs Settings list.

Selecting Video/Digital 
Camera, ICM, or 
ColorSync automatically 
sets the Ink option to 
Color.

Note:
See Chapter 3 for 
information about using 
special media.
2-3



Custom Printing

Loire-PLUS.BK.book  Page 4  Friday, May 2, 2003  2:56 PM
8. Select the correct Paper Source, Paper Size, and other 
options for the media and feeder you’re using. 

9. Check the Current Settings box on the bottom of the menu 
to see if the other settings are correct for your document. 
If they’re correct, click OK or Print. (If you’re using 
Windows, click any other buttons that your application 
uses for printing.)

If the predefined settings are not quite what you want, 
follow the steps in the next section to change them.

Customizing Print Quality and 
Special Effects
If you need maximum control over your project, or you want to 
experiment with special effects, you can adjust individual 
settings in your printer software. Follow these steps:

1. Create your document, image, or project in your 
application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-9 (Macintosh). 

Note:
After you customize your 
print settings for a special 
project, you can save 
them as a group. Then 
you can reuse them 
whenever you print a 
similar project. See 
page 2-12 for instructions.
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3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box:

Windows

Some of these options 
are automatically set 
or disabled by other 
settings you choose

Macintosh

Some of these options 
are automatically set 
or disabled by other 
settings you choose
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4. Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. Saves 
ink.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 
360 dpi Ink Jet or Banner paper.

◗ Fine - 720 dpi
For high-resolution output. Works best on photo 
quality media (including EPSON Photo Quality 
Banner paper), back light film, or canvas cloth.

◗ SuperFine - 1440 dpi
For the highest-resolution output on photo quality 
media, back light film, or canvas cloth only.

5. Choose the Media Type setting you want to use, following 
the guidelines on page 3-4. 

6. Press the Media Type button on the printer’s control panel 
to select the media you loaded in the printer and selected in 
step 5. If your media type is not listed on the control panel, 
select Other/Media Selection Off.

7. Select Color or Black ink.

8. Choose one of the following Halftoning options:

◗ No Halftoning
For printing black text only.

◗ Error Diffusion
For printing photographic or video/digital camera 
images. Blends each dot of color with the surrounding 
dots.

◗ Fine Dithering, Coarse Dithering
For printing charts, graphs, and other images that 
require precise, solid areas of bright colors. Arranges 
dots in orderly patterns. Use Coarse for images with 
more shading and less detail. Use Fine for images with 
more detail and less shading.

Note:
The Print Quality is 
selected automatically 
depending on the current 
Media Type. If you choose 
a Print Quality setting that 
is not appropriate for your 
media, the driver changes 
the Media Type setting. 
Be sure to check both of 
these settings to make 
sure they are correct for 
the media you loaded.

Note:
In Automatic mode, the 
Halftoning setting is 
selected based on the 
data in your print job. 
In Advanced mode, 
Halftoning is preselected 
for each document type 
setting. The No Halftoning 
option is available only 
when you select Black as 
the Ink setting.
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9. Choose any of the following print options. Some of these 
settings are automatically selected or disabled by the Print 
Quality (resolution) and Media Type settings you chose.

◗ MicroWeave
For improved print quality. Prints graphic data in finer 
increments to eliminate unwanted banding effects 
(light horizontal lines). Always use for color printing.

◗ High Speed
For fast, bidirectional printing at lower quality.

◗ Flip Horizontal
Prints a mirror image of your document. 

◗ Finest Detail
For printing text, graphics, and line art with very sharp 
edges. Slows print speed and increases your system 
memory requirements. 

10. If you’re ready to print, click OK and go to step 11. If you 
want to adjust your printer’s color settings, see the next 
section.

11. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 2-12 for instructions.

12. Click OK (Windows) or Print (Macintosh). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

If vertical lines in your 
printout are misaligned 
when you use the High 
Speed setting, you may 
need to align the print 
heads. See Chapter 5 for 
instructions.
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Customizing Color Settings
You can choose from several color adjustment modes or 
manually adjust brightness, contrast, saturation, and individual 
CMY (cyan, magenta, yellow) colors. To achieve maximum 
color accuracy, you can use Image Color Matching (ICM) 
under Windows or ColorSync on the Macintosh.

Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on 
page 2-4. The color settings appear on the right side of the 
dialog box, as shown:

Click to set Color Adjustment Mode

Drag sliders to 
set values 
between -25% 
and +25%

Macintosh

Windows
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2. Choose one of the following Color Adjustment Modes or 
choose another mode, as described in step 4:

◗ Automatic
Analyzes the color information in your project and 
optimizes color correction accordingly.

◗ Photo-realistic
For printing color photographs. 

◗ Vivid
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ No Color Adjustment 
In Windows, disables the color adjustment features of 
the printer software so you can adjust colors using your 
application. On a Macintosh, choose this mode only if 
you’re using ColorSync along with a custom ICC 
profile.

3. If you want to change individual color characteristics, use 
the scroll bars to increase (drag right) or decrease (drag left) 
the settings listed below. (If you use one of the options 
described in step 4, you won’t be able to specify individual 
color characteristics.)

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the bright 
or dark parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink 
colors that combine to make a full-color picture. Use to 
fine-tune the color balance in your printout.
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4. To fine-tune color correction for video/digital images or to 
closely match screen colors, choose one of these modes 
instead of a Color Adjustment Mode:

◗ Video/Digital Camera (not available for 
Windows NT)
Use for printing images captured from a digital camera 
or video. Increases contrast and saturation and makes 
the image sharper.

◗ ICM (Windows only)
Automatically adjusts printout colors to closely match 
colors on the screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match 
colors on the screen. See “Using ColorSync on the 
Macintosh” below for instructions.

5. Click OK to return to the Main printer settings dialog box.

6. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 2-12 for instructions.

7. Click OK (Windows) or Print (Macintosh). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Using ColorSync on the Macintosh
Every device you use for viewing or producing colors—your 
monitor, scanner, and printer—uses a different color 
technology. That’s why it’s difficult to get printed colors to 
match the colors displayed on your monitor. 

Each device has its own gamut, or range of colors, that it can 
reproduce. The Macintosh ColorSync system translates colors 
from one gamut to another so your monitor’s colors match your 
printer’s colors as closely as possible. 

Note:
When you choose 
Video/Digital Camera, 
ICM, or ColorSync, 
the individual color 
characteristics described 
in step 3 are preset.

The availability of ICM 
depends on your Print 
Quality, Media Type, and 
Halftoning settings.
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ColorSync uses profile information from each device—
including your EPSON Stylus COLOR 3000—to achieve 
accurate color matching. First you set your monitor’s profile. 
Then you can use your printer software to specify the exact 
method of “gamut mapping” (color matching) you want to use. 
Follow these steps:

1. Click ColorSync System Profile under Control Panels 
on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.

4. Close ColorSync System Profile.

5. Open the application you want to print from.

6. Access the printing dialog box as described on page 1-9. 
Click Advanced and then click More Settings.

7. Click ColorSync on the right side of the dialog box.

8. For Profile, choose EPSON Standard.

9. Choose one of the following options for Rendering Intent:

◗ Perceptual
For printing photographs. Adjusts the colors displayed 
on the monitor so they fit within the printer’s gamut, 
but maintains the relationships between colors.

◗ Saturation
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Maintains 
the relative saturation of colors from one gamut to 
another.

◗ Colorimetric
For matching colors as precisely as possible. Maintains 
colors that fall within the gamuts of the monitor and 
printer, but may lose some detail where the colors are 
outside the printer’s density range.

10. Click OK, and then click Print.

Note:
The EPSON Standard 
profile is custom-
designed for your printer. 
If you use a scanner or 
other color imaging 
equipment, you may have 
other profiles available.

The Saturation and 
Colorimetric options are 
only available when you’re 
using Fine - 720 dpi or 
SuperFine - 1440 dpi Print 
Quality.
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Saving Custom Settings
After you’ve fine-tuned your printer settings for a special 
project, you can save your settings as a group with a unique 
name and add it to the Custom Settings list on the Main menu. 
Then you can easily select the settings the next time you print a 
similar project. Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the Main printer 
settings dialog box. (If Save Settings is grayed out, click 
Advanced)

You see one of the following:

3. Type a unique name for your settings (up to 16 characters) 
and click the Save button.

The name you choose is now available on the Main printer 
settings dialog box when you click Advanced, and then 
Custom Settings.

Note:
You can save up to 
10 groups of settings.

If you change the Media 
Type or Ink setting when 
your customized setting 
is selected, the setting 
selected in the list 
changes to Custom 
Settings. To return to 
your customized setting, 
reselect it in the list. To 
redefine a customized 
setting, see page 2-13.

Macintosh

Windows
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Deleting Custom Settings

If you no longer need a customized setting, follow these steps to 
delete it:

1. Select Advanced mode. 

2. Click Save Settings.

3. Select the name of your custom setting group in the 
Custom Settings box, and click Delete. (You cannot delete 
any of the predefined document types.)

Redefining Custom Settings

To change the options in a customized setting group but keep 
the same name for it, follow these steps:

1. Select Advanced mode. 

2. Select the name of the custom setting group you want to 
redefine in the Custom Settings list.

3. Change the printer settings as necessary. (If you change the 
Media Type and Ink settings, the custom setting group 
name reverts to Custom Settings; this doesn’t affect your 
customized setting.)

4. Click Save Settings.

5. Select the name of the custom setting group you’re 
redefining in the Custom Settings box.

6. If you’re using Windows, click Save. You see the Save As 
dialog box. Click OK to save your redefined settings. (Click 
Cancel to cancel your changes.)

On a Macintosh, click the Redefine button. Then click 
Replace at the confirmation dialog box to save your 
redefined settings. (Click Cancel to cancel your changes.)
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3
Your EPSON Stylus COLOR 3000 lets you print on just about 
any kind of paper you want to use. You can get great results 
printing on plain paper, letterhead, and envelopes. But you’ll 
get the best results with EPSON’s specially coated ink jet paper. 

Your printer’s versatile feeding options let you load media of 
almost any size or format, including single sheets, continuous 
paper, and roll paper for banners and signs. You can even load 
two types of paper at once, switching between them with a flip 
of the paper-release lever when you’re ready to print on them.

This chapter covers the following:

◗ Using special media

◗ Printing on single sheets

◗ Printing on continuous paper

◗ Adjusting the loading and tear-off positions

◗ Switching between continuous and single-sheet paper

◗ Printing a banner or other roll paper project

Printing on
Special Media
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Using Special Media Types
The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. You can use most plain paper with your printer and 
achieve good results. For better results, use EPSON specially 
coated ink jet paper because it provides the best surface for the 
ink used in your printer. EPSON offers specially designed media 
for EPSON ink jet printers in a variety of sizes.

To order EPSON papers and other media, contact your dealer, 
call EPSON Accessories at (800) 873-7766, or visit 
www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral.
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Media name Size Part number

EPSON Photo Quality Ink Jet Paper Letter
A4
Legal
B
Super A3/B
A2
17 in. × 22 in.
16.5 in. × 49.2 ft roll

S041062
S041061
S041067
S041070
S041069
S041079
S041171
S041102

EPSON Matte Paper Heavyweight Letter
A3
Super A3/B

S041257
S041260
S041263

EPSON Photo Paper 4 in. × 6 in.
Letter
A4
A3
11 in. × 17 in.
Super A3/B
8.3 in. × 23.4 in 
13 in. × 32.8 ft roll

S041134
S041141, S041271, S041272
S041140
S041142
S041156
S041143
S041145
S041233

EPSON Glossy Paper A4
Letter
A2
Super A3/B
17 in. × 22 in.

S041126
S041124
S041123
S041133
S041151

EPSON Ink Jet Transparencies A4
Letter

S041063
S041064

EPSON Premium Luster Photo Paper Letter
Super A3/B
A3
8.3 in. × 32 ft roll
13 in. × 32 ft roll

S041405
S041407
S041406
S041408
S041409

EPSON Photo Quality Self Adhesive 
Sheets

A4 S041106

DuPont/EPSON Commercial Glossy 
Proofing Paper

Super A3/B S041160

DuPont/EPSON Commercial Matte 
Proofing Paper

Super A3/B S041203
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Media Loading and Software Settings 
Guidelines

Whether you print on plain paper or special media, you need to 
load it according to the guidelines in the table below. You must 
also be sure to select the correct Media Type setting in your 
printer software and on the printer’s control panel to match the 
media you loaded. See page 3-5 for additional guidelines..

1 Load with the short edge leading into the feeder. Remember to set the thickness lever forward.

When you load media with this 

name . . .

Load a maximum of this 

many sheets in the built-in 

sheet feeder as described on 

page 3-7 . . .

Then select this Media 

Type setting in your 

printer software . . .

Plain paper (single sheets) 100 letter size
30 Super A3/B size
30 A2 size 

Plain paper

Envelopes (remember to set the 
thickness lever forward)1

10

Labels (single sheets) (See “Loading Paper in the 
Manual Feeder” on page 3-12.)

Continuous label paper (See “Printing on Continuous 
Paper” on page 3-15.)

EPSON Photo Quality Ink Jet 
Paper

70 letter size
30 legal size
30 Super A3/B
30 A2 size

Photo Quality Ink Jet Paper

EPSON Photo Quality Self 
Adhesive Sheets

(See “Loading Paper in the 
Manual Feeder” on page 3-12.)

EPSON Ink Jet Transparencies 
(use with support sheet)

30 letter size Ink Jet Transparencies
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Additional Media Loading Guidelines

◗ If the corresponding Media Type option for your paper is 
not shown in the Media Type list, change the Print 
Quality setting in the More Settings dialog box, select 
Automatic as the Mode setting, or change the predefined 
setting in the Custom Settings list on the Main menu. See 
Chapter 2 for more information.

◗ In addition to the Media Type option, remember to select 
the correct Paper Size for your media.

◗ Some special media have a cut corner that you need to 
position correctly; follow any instructions in the package. 
Always handle sheets by the edges, and don’t touch the 
printable surface.

If the special media has protective sheets between each sheet 
of media, be sure to remove the protective sheets before 
printing.

◗ Be sure to load the printable side of the media in the correct 
direction for the feeder you’re using. When you’re loading 
pre-printed paper, such as letterhead or forms, position the 
paper as follows:

◗ Load it with the top edge leading into the printer

◗ Place the printable side:
Down in the sheet feeder
Up in the manual feeder, on the built-in tractor feeder, 
or on the roll paper feeder

◗ Use ink jet papers within one year of purchase. Use glossy 
media and transparencies within six months. Return 
unused sheets and envelopes to their original packages as 
soon as possible. See Appendix B for more media storage 
information.

◗ Some EPSON media include a cleaning sheet. After you 
finish printing a package of EPSON media, use the cleaning 
sheet included with the media. See the instructions on the 
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cleaning sheet for more information. Be sure to load the 
cleaning sheet in the paper tray with the cut corner 
positioned as shown below:

◗ See the following sections for complete media loading 
instructions:

◗ See page 3-7 for paper tray (built-in sheet feeder) 
instructions

◗ See page 3-12 for manual feeder instructions

◗ See page 3-15 for continuous paper instructions.

◗ See page 3-24 for banner paper instructions.

Printing on Single Sheets
You can print on single sheets of paper up to 17 inches wide 
(432 mm) in your printer using the paper tray (built-in sheet 
feeder) or the manual feeder.

You’ll probably use the paper tray at the front of your printer 
for the paper size you use most often. Then you can use the 
manual feeder at the top of the printer for loading individual, 
large format sheets or roll paper held in the roll paper holder. 
(See page 3-23 for more information on the roll paper holder.) 

Follow the instructions in the sections below to load single 
sheets of paper from these feeders.

cut corner
3-6



Printing on Special Media

Loire-PLUS.BK.book  Page 7  Friday, May 2, 2003  2:56 PM
Loading Paper in the Paper Tray

You can load any type of paper up to 17 inches wide (432 mm) 
in the paper tray, but do not load the stack above the arrow 
mark on the right edge guide. If you load paper more than 
14.3 inches (364 mm) wide, load a maximum of 30 sheets at a 
time, regardless of the paper type. Always load paper before you 
send a print job.

1. Turn on the printer.

2. Move the paper-release lever backward to the single sheet 
position.

3. Set the thickness lever backward to the 0 position for plain 
paper, ink jet paper, transparencies, transfer paper, and 
labels. 

Set the thickness lever forward to the + position for 
envelopes, ink jet cards, and heavy paper.

Note:
The maximum printable 
width is 16.3 inches 
(416 mm) on any size 
paper.
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4. Open the printer hood and remove the paper tray cover.

5. If you’ll be printing on paper that is 16.5 inches (420 mm) 
wide or less, slide the right edge guide all the way left until 
it clicks into place.

If the paper is more than 16.5 inches (420 mm) wide, slide 
the right edge guide all the way right.

right edge 
guide
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6. Slide the left edge guide to match the approximate width of 
your paper. Then move the center support midway 
between the two edge guides.

7. If you are printing on paper longer than A4 (11.75 inches), 
fold down the rear edge guide and pull out the paper tray 
extension (the paper tray extension acts as the rear edge 
guide.) 

8. Fan your stack of paper and then even the edges.

right edge 
guide

center 
support

left edge 
guide

rear edge 
guide

paper tray
extension
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9. Load the stack with the printable side face down and slide 
it all the way into the feeder. Gently press the stack against 
the right edge guide.

If you are loading envelopes, place the envelopes face down 
with the flap edge leading into the feeder. You can load a 
maximum of 10 envelopes.
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If you are loading 4 × 6-inch photo paper, place the paper 
face down with the short edge leading into the printer.

10. Slide the left edge guide against the left side of the paper.

11. Slide in the rear edge guide or paper tray extension to 
match the length of your paper.

12. Replace the paper tray cover and close the printer hood.

If you’ve loaded paper longer than A4 (11.75 inches), pull 
out and unfold the paper tray cover extension to match the 
length of the paper tray.
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13. Now follow the instructions in Chapters 1 or 2 to select the 
correct Paper Source, Paper Size, and other settings in 
your printer software. Then send a print job.

◗ If the printer runs out of paper during a print job, 
reload the paper tray and press the Pause button to 
continue printing.

◗ If the ink smears on your document, set the thickness 
lever to the + position and reprint; see page 3-7.

◗ If your margins are not where you like them, adjust 
them in your application software. However, if the 
problem seems to be with your paper’s loading 
position, you can change it using the Micro Adjust 
buttons; see page 3-20 for instructions.

Loading Paper in the Manual Feeder

You can load one single sheet of paper in the manual feeder 
without removing paper from the paper tray. Load any type of 
paper that is between 4.1 inches (105 mm) and 17 inches 
(432 mm) wide. Always load paper before you send a print job.

1. Turn on the printer.

2. Move the paper-release lever backward to the single sheet 
position.

Note:
Make sure that paper 
isn’t loaded in the manual 
feeder at the top of the 
printer before sending 
your print job. If paper is 
loaded in the manual 
feeder, the printer will 
print on it instead of the 
paper in the built-in sheet 
feeder.

Note:
To load banner paper, 
canvas cloth, or other 
roll paper in the manual 
feeder, you must use 
the roll paper holder. See 
page 3-23 for 
instructions.
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3. Set the thickness lever backward to the 0 position for plain 
paper, ink jet paper, transparencies, transfer paper, and 
labels. 

Set the thickness lever forward to the + position for 
envelopes, ink jet cards, and heavy paper.

4. If any paper is currently loaded in the paper path from the 
paper tray or the tractor feeder, press the Load/Eject 
button to eject the paper or park it out of the way.

5. If you’ll be printing on paper that is 14.3 inches (364 mm) 
wide or less, slide the right edge guide on the manual feeder 
so its right edge aligns with the arrow mark on the manual 
feed guide.

If the paper is more than 14.3 inches (364 mm) wide, slide 
the right edge guide all the way right.

Note:
The maximum printable 
width is 16.3 inches 
(416 mm) on any size 
paper.
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6. Slide the left edge guide to the approximate width of your 
paper.

7. Load the paper with the printable side face up and its right 
edge against the right edge guide. Then gently slide it into 
the manual feeder until the printer pulls it in. 

You can load one envelope in the manual feeder face up 
with the flap edge leading into the feeder. Gently slide the 
envelope into the manual feeder until the printer pulls it in.

If the paper doesn’t load straight, press the Load/Eject 
button on the printer’s control panel to eject the paper; 
then load it again.
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8. Now follow the instructions in Chapters 1 or 2 to select the 
correct Paper Source, Paper Size, and other settings in 
your printer software. Then send a one-page print job.

◗ If the ink smears on your document, set the thickness 
lever to the + position and reprint; see page 3-13.

◗ If your top and bottom margins are not where you like 
them, adjust them in your application software. 
However, if the problem seems to be with your paper’s 
loading position, you can change it using the Micro 
Adjust buttons; see page 3-20 for instructions.

To print another document in the manual feeder, load the 
paper as described above. To switch back to printing from the 
paper tray, press the Pause button to turn off the Pause light. 
Then send another print job.

Printing on Continuous Paper
You can load continuous paper in the built-in tractor feeder on 
the back of the printer without removing paper from the paper 
tray. Load any type of continuous paper that is between 
4 inches (102 mm) and 16 inches (406 mm) wide, such as 
greenbar computer paper, fanfold banner paper, or continuous 
label paper. Always load paper before you send a print job.

1. Turn on the printer.

2. Set up your printer so there’s enough room in the back to 
feed the paper and enough room in front for the printed 
pages to stack without obstruction. Position the paper 
supply within 3 feet (1 meter) of the printer.

Note:
Make sure that paper 
isn’t loaded from the 
paper tray before sending 
a print job for paper in the 
manual feeder. If paper is 
loaded from the paper 
tray, the printer will print 
on it instead of the paper 
in the manual sheet 
feeder.

When you print on 
continuous paper, it is a 
good idea to turn on auto 
tear-off mode so the 
printer paper can advance 
to the tear-off position 
automatically. Follow the 
instructions on page B-8.

Note:
The maximum printable 
width is 15 inches 
(381 mm) on continuous 
paper.
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3. Move the paper-release lever forward to the continuous 
paper position.

4. Set the thickness lever backward to the 0 position.

5. Remove the manual feed guide by lifting it off the printer.

Caution:
If you load continuous 
label paper, make sure 
the printer’s auto tear-off 
feature is turned off. If 
you have this feature 
turned on, labels could 
be fed backward and 
peel off inside the 
printer. See page B-8 for 
instructions on changing 
the auto tear-off setting 
using default-setting 
mode.
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6. Pull up the blue sprocket-lock levers to unlock them so you 
can slide the sprockets into position.

7. Slide the left sprocket all the way right until it stops. Press 
down the sprocket-lock lever to lock it in place.

8. Slide the right sprocket to the approximate width of your 
paper. Then position the center support midway between 
the two sprockets, as shown in the previous illustration.

9. Flip open both sprocket covers.

sprocket-lock levers

center support
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10. Arrange the continuous paper stack so the printable side is 
face up. Fit the first four holes over the sprocket pins on 
both sprockets; then close the sprocket covers.

11. Slide the right sprocket to remove any slack in the paper. 
Then press down the sprocket-lock lever to lock it in place. 
If necessary, align your stack of continuous paper so it will 
feed straight into the tractor feeder.

12. Reinstall the manual feeder on the top of the printer.

13. Make sure the edge of the paper tray is beneath the paper 
tray cover so the continuous paper does not catch on it as it 
ejects.

Note:
If you run out of 
continuous paper while 
printing, the Paper Out S 
and Pause lights come 
on. Load more paper on 
the tractor feeder and 
press the Pause button 
to continue printing.
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14. Follow the instructions in Chapters 1 or 2 as necessary to 
send a print job. Be sure to select Tractor Feeder as the 
Paper Source option and then choose the correct Paper 
Size. The continuous paper loads and printing begins 
when the printer receives the print job.

Follow the steps in the next section to remove continuous paper 
correctly.

Removing Continuous Paper

When you’ve finished printing a continuous paper document, 
you must carefully follow these steps to remove it from the 
printer, depending on your media type and the setting of the 
auto tear-off feature. 

1. If the printer’s auto tear-off feature is turned on, your 
continuous paper is automatically advanced to the tear-off 
position at the end of a print job. Go to step 2.

If the auto tear-off feature is turned off (the default setting), 
press the LF/FF button as many times as necessary to 
advance the last printed sheet to the tear-off edge. Go to 
step 2.

If the auto tear-off feature is turned off (the default setting), 
and you’re printing labels, tear off the next sheet of labels at 
the back of the printer. Then press the LF/FF button on the 
printer’s control panel as many times as necessary to eject 
the remaining pages from the printer. Do not perform 
steps 2 and 3.

Caution:
If you need to adjust the 
loading position, see 
page 3-21. Never use the 
knob on the left side of 
the printer to adjust the 
loading or tear-off 
positions. This would 
damage your printer and 
cause it to lose the 
top-of-form position.

Note:
See Appendix B for 
information on using 
default-setting mode to 
change the auto tear-off 
setting for your print job.
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2. Lift the printer hood and tear off the printed pages at the 
perforation by pulling it across the tear-off edge.

If the paper’s perforation was not at the printer’s tear-off 
edge, adjust the tear-off position as described on page 3-22. 
Do not perform step 3.

3. Press the Load/Eject button to feed the rest of the 
continuous paper backward to the paper-park position so 
it’s ready for printing the next time you need it.

If the ink smears on your document, you can set the thickness 
lever to the + position and reprint; see page 3-13.

If your margins are not where you want them, adjust them in 
your application software. However, if you need to adjust your 
paper’s loading position, you can change it using the Micro 
Adjust buttons. See the next section for instructions.

Using the Micro Adjust Buttons
The Micro Adjust U and Micro Adjust D buttons on your 
printer’s control panel allow you to make quick adjustments to 
your paper’s loading and tear-off positions. 

Caution:
Never press Load/Eject 
when you have 
continuous label paper 
loaded in the printer. 
This would feed labels 
backward, causing 
them to peel off inside 
the printer.
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Adjust the paper’s loading position if you notice that printing is 
too high or low on the page and the position cannot be 
corrected in your software program. You can even set separate 
loading positions for continuous paper, manually fed paper, or 
paper tray fed paper. The settings you make remain in effect 
until you change them again, even when you turn off the 
printer.

If you’re using continuous paper and the perforation does not 
align with the printer’s tear-off edge when you’re done printing, 
you can use these buttons to adjust the tear-off position.

Adjusting the Loading Position

Follow these steps to adjust the loading position of your paper:

1. If you have continuous and single sheet paper loaded at the 
same time, the loading position you adjust is determined by 
the setting of the paper-release lever. 

For continuous paper, set the paper-release lever backward 
to the continuous paper position. 

For paper in the sheet feeder or the manual feeder, set it 
forward to the single sheet position.

2. Press the Load/Eject button to load a sheet of paper or load 
the first continuous sheet to the top-of-form position.

3. Press the Micro Adjust U button to feed paper backward 
or the Micro Adjust D button to feed paper forward. Press 
either button as many times as necessary to adjust the 
position. When the adjustment reaches the maximum 
setting for your printer, it does not move further.

4. Follow the instructions in Chapters 1 or 2 as necessary to 
send a print job.

The loading position you select remains in effect until you 
change it again, even when you turn off the printer.

Caution:
Never use the knob on 
the left side of the printer 
to adjust the loading or 
tear-off positions. This 
would damage your 
printer and cause it to 
lose the top-of-form 
position.
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Adjusting the Tear-off Position

First make sure that continuous paper is loaded and parked in 
the current tear-off position (see page 3-19 for details). Follow 
these steps to adjust the tear-off position:

1. Press the Micro Adjust U button to feed paper backward 
or the Micro Adjust D button to feed paper forward. Press 
either button as many times as necessary to align the 
perforation with the tear-off edge. When the adjustment 
reaches the maximum setting for your printer, it does not 
move further.

2. Tear off any printed pages.

3. Press the Load/Eject button to feed the rest of the 
continuous paper backward to the paper-park position so 
it’s ready for printing the next time you need it.

The tear-off position you select remains in effect until you 
change it again, even when you turn off the printer.

For instructions on setting your printer’s auto tear-off mode, see 
Appendix B.

Switching Between Continuous 
and Single Sheet Paper
When you have both continuous paper and single sheet paper 
loaded in the paper tray, you can switch between paper types 
whenever you need to print on them. Follow these steps:

1. If continuous paper remains inside the printer, tear off the 
printed pages. Then press the Load/Eject button on the 
printer’s control panel to feed the paper backward to the 
paper-park position.

If single sheet paper is loaded, press the Load/Eject button 
to eject any sheets still inside the printer.

Caution:
Never adjust the tear-off 
position when you’re 
printing labels. This could 
feed labels backward, 
causing them to tear off 
inside the printer.
3-22



Printing on Special Media

Loire-PLUS.BK.book  Page 23  Friday, May 2, 2003  2:56 PM
2. To switch to single sheet printing, move the paper-release 
lever backward to the single sheet position.

To switch to continuous paper printing, move the 
paper-release lever forward to the continuous paper 
position.

3. Now follow the instructions in Chapters 1 or 2 to select the 
correct Paper Source, Paper Size, and other settings in 
your printer software. Then send a print job. The printer 
loads the type of paper you selected when it receives the 
print job.

Printing a Banner or Other Roll 
Paper Project
You can use EPSON roll paper to print a banner up to 44 inches 
long. 

First follow the instructions below to load the paper. (You can 
also print a banner on continuous computer paper. See 
page 3-15 for paper loading instructions.) Then see the 
appropriate printing instructions for your software—Windows 
or Macintosh—in the sections that follow.

For best results and a more professional looking banner, the 
optional banner paper cutter (C815052) is recommended. 
Contact your dealer, call EPSON Accessories at 
(800) 873-7766, or visit www.epsonstore.com (U.S. sales only). 
In Canada, please call (800) 463-7766 for dealer referral.

Note:
If the Pause and Paper 
Out S lights flash, you 
may have changed the 
paper-release lever 
position when paper was 
still loaded. Set the lever 
back to its original 
position and press the 
Load/Eject button to 
eject or park the paper. 
Then set the lever to its 
new position.
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Loading Roll Paper

1. Before you load roll paper, follow the instructions on 
page B-8 to set up the printer for banner printer using 
default-setting mode. Select these options:

◗ Turn banner mode on so the printer doesn’t advance 
all the roll paper out of the printer if you press the 
LF/FF button.

◗ Turn auto tear-off mode on so the printer can advance 
the roll paper to the correct cut-off position.

When you’ve finished setting these options, turn off the 
printer to exit default-setting mode, wait 5 seconds, then 
turn on the printer before continuing with step 2.

2. Move the paper-release lever backward to the single sheet 
position.

3. Set the thickness lever backward to the 0 position.

Caution:
Do not insert paper before 
you turn on the printer.
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4. Open the banner paper cover.

5. Slide both edge guides as far away from the center as they 
can go.

6. Position the banner paper roll so that the paper feeds into 
the printer from the top of the roll (the printable side is 
face up).

Place the banner paper roll on the right roll paper holder. 
Then slide the left banner paper holder to match the roll’s 
width. Make sure the holders are snug against the banner 
paper roll, but do the squeeze the paper too tightly; 
otherwise the roll will not rotate properly.
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7. Make sure the roll paper is tightly wound on the roll. While 
holding both ends of the roll, slowly feed the paper into the 
manual feed slot until it meets resistance. The printer 
automatically feeds the paper to the loading position. (If 
the paper is crooked, press the Load/Eject button to 
backfeed the paper and try loading it again.)

8. Follow the instructions below to print your banner on 
either a Windows computer or a Macintosh.

Printing a Banner from Windows

Follow these steps to print a banner or other custom-size project 
on a Windows computer:

1. Create the document in your word processor or other 
application software. You can create a banner in either 
portrait or landscape orientation. 

2. Choose Print or Print Setup from the File menu. You see a 
printing dialog box for your application.

3. Make sure your printer is selected, and then click the 
Printer, Setup, Properties, or Options button. (You may 
have to click a series of these buttons, depending on your 
software.) You see the Main printer settings dialog box, as 
shown on page 1-2.
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4. Click the Paper tab. You see a dialog box like the 
following:

5. If you’re printing on roll paper, select Manual Feed 
Slot (Banner) from the Paper Source list. At the end of the 
Paper Size list, select one Long Paper 17 × n options, 
where n is the length of your banner (up to 44 inches). If 
your paper size is not in the list, go to step 6; otherwise, 
continue with step 7.

If you’re printing a banner on continuous computer paper, 
select Tractor Feeder for the Paper Source. At the end of 
the Paper Size list, select one of the Fanfold nn × n in. 
options, where nn is the width of your paper and n is the 
length of your banner. If your paper size is not in the list, 
go to step 6; otherwise, continue with step 7.

Click to select a 
paper size

Click to select a 
paper source

Note:
Your software application 
may allow you to print 
a banner longer than 
44 inches. See your 
software documentation 
for details.
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6. At the end of the Paper Size list, choose User Defined. The 
following dialog box appears:

Type in your paper’s width in the Paper Width field 
and a length up to 44 inches for the Paper Height. (This 
works for banners in either landscape or portrait 
orientation.) Click OK. Go to step 7.

7. Choose Portrait or Landscape if you haven’t already 
specified the orientation in your application software. Set 
the printable area if necessary.

8. Click the Main tab to return to the Main printer settings 
dialog box. 

9. Choose the Media Type setting that matches your banner 
paper or canvas cloth as described in the table on page 3-4. 
(For continuous computer paper, choose Plain Paper.) 

Check the rest of the printer software settings as described 
in Chapters 1 and 2. Then click OK. 

10. Click Close, OK, or Print to print your banner. (You may 
need to click a series of these buttons, depending on your 
software.)

For banner printing, type 
any size up to 44 inches

Note:
With Windows NT, the 
User Defined Paper Size 
dialog box includes 
settings for units of 
measure, naming of the 
paper size (up to 16 
characters), and saving of 
multiple user defined 
paper sizes. For 
instructions on using 
these settings, click the 
Help button at the bottom 
of the Paper dialog box.
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11. When your print job finishes printing, the printer feeds the 
paper to the default cut off (or tear off) position (as long as 
the auto tear-off feature is on in default-setting mode). If 
necessary, press the Micro Adjust buttons to move the 
paper forward or backward to the cut off position.

12. If you are using the optional Banner Paper Cutter, follow 
the instructions on page 3-32. Otherwise, use scissors to cut 
the paper.

To remove continuous paper, see page 3-19.

If you want to print another roll paper project, the printer feeds 
the roll paper back to the loading position when it receives a 
new print job.

If you won’t be using your roll paper for awhile, store it in its 
original packaging. See Appendix B for optimum storage 
conditions. 

Before printing on another type of paper, be sure to change the 
Paper Source, Paper Size, and Media Type settings in your 
printer software as described in Chapters 1 and 2. 

Also be sure to turn off banner mode using the default-setting 
mode instructions on page B-8.

Note:
The printer saves the cut 
off (or tear off) position 
and it remains in effect 
until you change it again, 
even after turning off the 
printer.
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Printing a Banner from a Macintosh

Follow these steps to print a banner or other custom-size project 
on a Macintosh:

1. Create the document in your word processor or other 
application software. You can create a banner in either 
portrait or landscape orientation. 

2. Choose Page Setup from the File menu. You see a dialog 
box like the following:

3. If you’re printing on roll paper, select Manual Feed 
Slot(Banner) from the Paper Source list. 

If you’re printing a banner on continuous computer paper, 
select Tractor Feeder for the Paper Source. 

4. Click the Customize button.The following dialog box 
appears:

5. Click the New button. 

Click to select your 
paper size

Click to define a 
custom paper size

Click to select your 
paper source

You can create up to eight 
custom paper sizes. Give 
each one a unique name 
so you’ll be able to reuse 
them by selecting them 
from the Page Size list in 
the Page Setup dialog 
box.

Click to 
create a new 
paper size
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6. Type a name for your custom size in the New Paper Size 
box. Then type your paper’s width in the Width field and a 
length of up to 44 inches for the Height. (This works for 
banners in either “landscape” or “portrait” orientation.) 
Click OK.

7. Choose Portrait or Landscape, depending on the 
orientation of the banner or document you created. Set the 
printable area if necessary.

8. Click OK.

9. Choose Print from the File menu or click the print icon in 
your application. You see a printer settings dialog box (as 
shown on page 1-9). 

10. Choose the Media Type setting that matches your banner 
paper or canvas cloth as described in the table on page 3-4. 
(For continuous computer paper, choose Plain Paper.) 

11. Check the rest of the printer software settings as described 
in Chapters 1 and 2. Then click Print to print your banner.

12. When your print job finishes printing, the printer feeds the 
paper to the default cut off (or tear off) position (as long as 
the auto tear-off feature is on in default-setting mode). If 
necessary, press the Micro Adjust buttons to move the 
paper forward or backward to the cut off position.

13. If you are using the optional Banner Paper Cutter, follow 
the instructions on in the following section. Otherwise, use 
scissors to cut the paper.

To remove continuous paper, see page 3-19.

If you want to print another roll paper project, the printer feeds 
the roll paper back to the loading position when it receives a 
new print job.

If you won’t be using your roll paper for awhile, store it in its 
original packaging. See Appendix B for optimum storage 
conditions. 

Note:
Your software application 
may allow you to print a 
banner longer than 44 
inches. See your 
software documentation 
for details.

Note:
The printer saves the cut 
off (or tear off) position 
and it remains in effect 
until you change it again, 
even after turning off the 
printer.
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Before printing on another type of paper, be sure to change the 
Paper Source, Paper Size, and Media Type settings in your 
printer software as described in Chapters 1 and 2. 

Also be sure to turn off banner mode using the default-setting 
mode instructions on page B-8.

Removing a Printed Banner

Follow these steps to remove a printed banner using the 
optional banner paper cutter:

1. If you turned auto tear-off mode on (as instructed in step 1 
on page 3-24), the printer automatically feeds the paper to 
the tear-off position when it’s finished printing. If you 
didn’t turn on auto tear-off mode, press the LF/FF button 
to advance the paper to the cut-off position.

Press Micro Adjust D and Micro Adjust U buttons as 
necessary to move the end of the banner to the edge of the 
banner paper cutting guide.

2. Insert the left edge of the paper into the slot on the cutting 
unit. 

3. Slowly slide the cutting unit all the way to the right while 
lifting up slightly on the left edge of the paper. If you slide 
the cutting unit too quickly, apply uneven pressure, or pull 
on the paper, your banner will have an uneven, rippled 
edge instead of a smooth one.

4. Slide the cutting unit all the way to the left. Otherwise, the 
next time you print, you may get a paper jam.

5. If you want to print another roll paper project, the printer 
will feed the roll paper back to the loading position when it 
receives a new print job. Go to step 10.

If you won’t be using the roll paper again right away, 
continue with step 6.

Note:
If you purchased the 
optional banner paper 
cutter, see its 
documentation for 
installation instructions.

The roll paper cut-off 
position you set remains 
in effect until you change 
it again, even when you 
turn off the printer.
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6. Press the Load/Eject button to eject the paper backward. 

7. Using your hands, roll back the paper all the way out of the 
manual feed slot and onto the roll. When it’s completely 
out, the Pause and Paper Out S lights turn on. 

8. Press the Pause button to turn off the lights.

9. If you won’t be using your roll paper for awhile, store it in 
its original packaging. See Appendix C for optimum 
storage conditions. 

10. Before printing on another type of paper, be sure to change 
the Paper Source, Paper Size, and Media Type settings 
in your printer software as described in Chapters 1 and 2. 

Also be sure to turn off banner mode using the 
default-setting mode instructions on page B-8.

If you’ll be printing on continuous paper, also be sure to 
reset the paper-release lever, as described on page 3-16.

Note:
You don’t need to 
remove the banner paper 
cutter when printing on 
other media. Simply slide 
it all the way to the left 
when you’re finished 
cutting with it. 

If you need to remove 
the banner paper cutter, 
see its documentation 
for removal instructions.
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4
Your printer software includes several utilities for managing 
print jobs. You can use them to monitor your printer’s status, 
set up large jobs to print later, and handle network printing. If 
you’re using your printer on a network, you need to follow the 
special setup procedures in this chapter. 

This chapter provides instructions for the following:

◗ Managing print jobs with Windows 

◗ Managing print jobs with Windows NT

◗ Managing print jobs on a Macintosh

◗ Network printing on a PC

◗ Network printing on a Macintosh

Managing Print Jobs With 
Windows
Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

◗ The Spool Manager starts automatically when you send a 
job to the printer (Windows Me/98/95). It allows you to 
print in the background while you continue to work on 
your computer and to hold jobs to print at a later time. If 
you’re using your printer on a network, it also handles 
multiple print jobs that come in at the same time.

Managing
Print Jobs and

Network Printing
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◗ The Status Monitor also starts automatically when you 
send a job to the printer. It displays on your screen to alert 
you about printer, paper, and ink status. 

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. 
When you send a job to your printer, your printer software 
creates a temporary print job file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to a 
print queue. The software then sends the file to your printer at 
the right time.

◗ To open the Spool Manager while you’re printing, click 
the Spool Manager icon that appears on the Taskbar. 

◗ To open it at any time, double-click the Spool Manager4 
icon in the EPSON program group or folder.

You see the Spool Manager window:

The Spool Manager window displays the status of your print 
queues and print jobs and lets you control them. Here are some 
of the things you can do:

◗ Hold or release a queue

◗ Send print jobs to your printer over a network 

◗ Hold, re-queue, or delete a print job

◗ Prevent the Despooler window from appearing on your 
screen whenever you print (see page 1-7 for information on 
the Despooler window)

◗ Change your default spool directory

Note:
EPSON Status Monitor 
will not display ink levels 
if you are using Windows 
98 or Me and connecting 
to the printer through a 
USB port or through a 
network.

menus

print job 
file

queue

For information about any 
of these procedures, use 
the Spool Manager Help 
utility.
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Deleting a Stalled Print Job

If you have trouble printing, it may be because of a stalled print 
job. Follow these steps to delete it so you can continue printing:

1. Open the Spool Manager as described on page 4-2.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is 
very slow, you can try changing your default spool directory. 
Follow these steps:

1. Make a directory on your hard disk where you want 
Spool Manager to store print job files, for example, 
C:\SPLTEMP.

2. Open the Spool Manager as described on page 4-2.

3. Choose Default Spool Directory from the Options menu. 

4. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

5. Make sure EPSON Stylus COLOR 3000 is selected, and 
then choose Setup from the Queue menu. The Queue 
Setup dialog box appears.

6. Make sure the spool directory is the same as in step 1. Also 
make sure Use Print Manager for this port is checked. (If 
you’re using Windows 95 and don’t see the Status Monitor 
when you print, leave it unchecked.) Click OK.

7. Close Spool Manager.
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Using the Status Monitor

The Status Monitor displays automatically in the Despooler 
window when you send a print job to the printer. However, you 
can use it at any time to see how much ink you have left. Follow 
these steps:

1. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-9 (Macintosh).

2. Click the Utility tab. You see the Utility menu:

Note:
EPSON Status Monitor 
will not display ink levels 
if you are using Windows 
98 or Me and connecting 
to the printer through a 
USB port or through a 
network.

For information 
about these 
three utilities, 
see Chapter 5
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3. Click the EPSON Status Monitor icon.

You see the Despooler window with the Status Monitor 
(Media Check, Paper Status, and Ink Status) at the top:

4. Check the amount of ink and paper you have left. For more 
information about the Despooler window, see page 1-7.

Note:
To scroll through the 
settings in the Paper 
Status box and see the 
full names of the listed 
options, click in the field 
you want to view and use 
the arrow keys to view 
the option name.

Status Monitor 

Despooler
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Managing Print Jobs With 
Windows NT
Windows NT 4.0 servers and workstations include a messenger 
service to alert you to printer errors or let you know when a 
print job is finished. If you have appropriate network access 
privileges or you’re controlling printing from the server, you 
can also cancel, pause, or restart print jobs and set the sharing, 
security, scheduling, and port options. See your Windows NT 
documentation for details.

Managing Print Jobs on a 
Macintosh
Your Macintosh printer software includes two utilities for 
managing your print jobs: EPSON Monitor3 and Status 
Monitor. 

◗ If you’re using background printing, EPSON Monitor3 
starts automatically when you send a job to the printer. It 
handles printing while you continue to work on your 
Macintosh and lets you track documents that are waiting to 
be printed. 

◗ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it any time to see how 
much ink you have left. 
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Using EPSON Monitor3

The EPSON Monitor3 utility lets you continue to work on your 
Macintosh while your document is printing. To use this utility, 
however, you need to turn on background printing and increase 
the memory allocation for Monitor3. 

Follow these steps:

1. If you didn’t turn on background printing when you 
selected your printer, open the Chooser from the Apple 
menu. Select the SC3000 or SC3000(AT) icon. Under 
Background Printing, click On and close the Chooser.

2. To increase the memory allocated to Monitor3, select 
EPSON Monitor3 in the Extensions folder in your System 
folder. Then choose Get Info from the File menu and set 
the Memory Requirements to 2000K or 3000K, depending 
on your system’s available RAM.

3. To use Monitor3 while you’re printing, select the EPSON 
Monitor3 icon in the Application menu at the right end of 
the menu bar. You see a dialog box like the following:

If you’re not using background printing and you need 
to concel printing, hold down the J key and press the 
. (period) key.

Note:
Background printing is 
slower and may also slow 
down your system. 

Select your print 
job, then click here 
to cancel printing

Click here to 
show the 
print settings

Click to check 
ink levels
4-7



Managing Print Jobs and Network Printing

Loire-PLUS.BK.book  Page 8  Friday, May 2, 2003  2:56 PM
Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your 
printer and to control the way your software warns you about 
printer problems. Follow these steps:

1. Choose Print from the File menu or click the print icon in 
your application. You see the printer settings dialog box.

2. Click the Utility button. You see the Utility menu:

3. Click the Status Monitor icon. The software checks the 
amount of ink remaining and displays the Status Monitor:

For 
information 
about these 
three utilities, 
see Chapter 5

Click to recheck 
ink level
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Network Printing on a PC
You can use your printer on a network under Windows or 
another network operating system. First you need to set up your 
printer using either the network’s printer port setup functions 
or your printer software’s built-in network support.

If you’re setting up your printer for Windows XP or 2000, see 
the instructions on page 4-9. For Windows NT, see page 4-11. 
For other network operating systems, see your network 
documentation for instructions or use the printer software’s 
network support, as described on page 4-12.

Setting Up a Network Port on Windows XP 
or 2000

The process of setting up a network port is similar on Windows 
XP and Windows 2000. Although this section shows Windows 
XP, you’ll see similar screens in Windows 2000. For either 
system, make sure you are logged in to the computer as an 
administrator.

1. Do one of the following:

◗ In Windows XP, click Start > Control Panel > 
Printers and Other Hardware > Printers and 
Faxes. 

◗ In Windows 2000, click Start > Settings > Printers.

2. Right-click the EPSON Stylus COLOR 3000 printer icon, 
then click Properties.

3. On the Ports tab, click Add Port. 

Note:
If you need to install a 
network interface card 
in your printer, see the 
Quick Setup guide for 
instructions.
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You see this window:

4. Select Standard TCP/IP Port and click New Port. You see 
the Add Standard TCP/IP Printer Port wizard.

5. Click Next. You see a window like this:

6. In the Printer Name or IP Address box, enter the 
printer’s name or IP address and click Next.

7. Follow the instructions on the screen to complete the 
wizard.

8. Click Close to close the Printer Ports window, then click 
Apply on the Properties window.
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Connecting to the Printer on 
Windows NT 4.0 

If you installed an optional network interface card in your 
printer and installed the printer software as described in the 
Quick Setup booklet, follow the steps below to connect the 
remote printer to each system on the network using the TCP/IP 
(or LPR) protocol.

1. Follow the instructions to configure the interface card in 
the manual that came with the card.

2. To connect the printer to a TCP/IP (or LPR) port, open 
the Control Panel and select Printers.

3. Right-click the EPSON Stylus COLOR 3000 icon, then 
select Properties.

4. Select the Ports tab and click the Add Port button.

5. Select LPR Port in the Port list. Then click New Port.

6. Type the IP address of the card in the first box and type a 
short name for the printer in the second box. Then click 
OK.

7. Click Close. 

8. You see the address and name of the printer in the Port list. 
Click OK to exit printer properties.

Now you can print to the remote printer. Repeat these steps for 
each system on the network that needs to access the printer.

Note:
If you connected the 
printer directly to a 
Windows NT server or 
you’re using a different 
network protocol, see 
your Windows NT 
documentation for 
instructions on 
configuring your printer 
for the network. If you’re 
using an optional 
interface card, also see 
the documentation that 
came with the card.
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Using the Printer Software’s Built-in 
Network Support for Windows Me/98/95

To use your printer software’s built-in network support, you 
first need to install the printer software on all the network 
computers that will use the printer. See the Quick Setup booklet 
for instructions. Once the printer software is installed, you can 
set up Spool Manager to send print job files from each 
computer to a shared directory on the computer connected to 
the printer. 

Follow the steps in the next sections to set up a print job 
directory on the system connected to the printer (the host 
system) and each remote system (client) on the network. You 
also need to specify the port and network path to the printer, as 
described on page 4-13.

Setting Up the Host System

Follow these steps to set up the computer connected to the 
printer:

1. Create an icon for the EPSON Spool Manager 
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Place this icon in the Startup folder.

3. Double-click the EPSON Spool Manager icon to open the 
Spool Manager window.

4. Double-click the queue you want to use for network 
printing. The Queue Setup dialog box appears.

5. Click the Remote Despool tab and then click the 
Printing from remote queues option.

6. Click the Browse button and select the remote server 
directory that will receive print job files.

7. Click OK and minimize the Spool Manager window.
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Setting Up Remote Systems

Follow these steps to set up client computers on the network:

1. Open the Spool Manager window as described on page 4-2.

2. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

3. Click the Spool to remote printer button.

4. Click the Browse button and select the directory you’re 
using for print job files on the host system.

5. Click OK and minimize the Spool Manager window.

Setting Up Your Network Path 

If you want to use your printer on a network running 
Windows Me/98/95, you need to set up the port and network 
path on the computer connected to the printer. Follow these 
steps:

1. Double-click My Computer.

2. Double-click the Printers folder.

3. Right-click the EPSON Stylus COLOR 3000 icon and 
choose Properties.
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4. Click the Details tab. The following dialog box appears:

5. Click the Add Port button, then specify the network path 
to the printer and click OK.

6. Open the Spool Manager window as described on page 4-2.

7. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is 
checked. Then click OK.
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Network Printing on a Macintosh
If you want to use your printer on an AppleTalk® network, you 
need to install the optional Ethernet™ card as described in the 
Quick Setup guide.

Then you can use the EPSON Namer utility and set up your 
printer in the Chooser. The EPSON Namer was installed on 
your hard drive along with the other printer software. 

Assigning a Name to the Printer

Follow these steps to use the EPSON Namer utility:

1. Double-click the EPSON Namer icon on your hard drive. 

2. Click the SC3000(AT) icon in the Device Types window.

3. Select the AppleTalk zone where your printer is located.

4. Under New Name, type a name from your printer to 
distinguish it from other printers on the network.

5. Click Rename and then click Done.
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Setting Up the Printer for AppleTalk

Make sure your printer is turned on and then follow these steps 
to set up your printer on an AppleTalk network:

1. Open the Chooser from the Apple menu. 

2. Click the SC3000(AT) icon.

3. Select the AppleTalk zone you want to use. A list of all 
printers connected to the selected zone appears on the right.

4. Click the name you assigned to your EPSON Stylus COLOR 
3000 in step 4 of the previous section. You see a prompt 
asking you to confirm your choice.

5. Click OK.

If your printer name doesn’t appear, make sure the printer 
is turned on and correctly connected, then click RETRY.

6. To ensure compatibility, leave Background Printing 
turned off.

7. Close the Chooser.
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5
It’s easy to keep your EPSON Stylus COLOR 3000 printer 
working at its best. All you have to do is follow the simple 
instructions in this chapter for replacing ink cartridges, 
performing routine maintenance, and moving the printer. 

This chapter covers the following procedures:

◗ Cleaning the print heads

◗ Replacing an ink cartridge

◗ Aligning the print heads

◗ Cleaning the printer

◗ Transporting the printer

Cleaning the Print Heads
If your printed image is unexpectedly light or faint, dots are 
missing from the image, or you see thin white lines, you may 
need to clean the print heads. This unclogs the nozzles so they 
can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. There are two ways to clean the print heads:

◗ The Head Cleaning utility in your printer software

◗ The printer’s control panel buttons. 

Use either method if your printer is connected directly to the 
computer. Use the control panel if your printer is connected via 
an optional network interface card.

Maintenance and
Transportation

Note:
You must print a few lines 
(for example, a nozzle 
check) after each print 
head cleaning in order to 
reset the cleaning cycle.
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Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows computer 
or a Macintosh:

1. Make sure the printer is turned on but not printing.

2. Make sure all the Ink Out B lights are off. 

3. Access the Main printer settings dialog box as described in 
Chapter 1.

4. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

5. Click the Head Cleaning icon.

6. Follow the instructions on the screen to clean the print 
heads. You can clean the black or color print head 
separately, or you can clean both. Cleaning each head takes 
up to three minutes, during which the printer makes some 
noise and the Operate and Pause lights flash. 

When the lights stops flashing, you need to run a nozzle 
check to test the print quality and reset the cleaning cycle.

7. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh), and then click Next. See page 5-4 for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this four or five 
times, check the print quality solutions in Chapter 6.

Note:
If any Ink Out lights 
are flashing or on, you 
need to replace the ink 
cartridge instead. See 
page 5-4 for instructions.

If you were printing when 
you started cleaning the 
print heads, the Pause 
light may still be on. Press 
the Pause button to turn 
off the light and resume 
printing.

Caution:
Never turn off the printer 
while the Pause light is 
flashing.

If, however, the Pause 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making any noise, you 
may turn off the printer.
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Using the Control Panel

1. Make sure the printer is turned on and not printing.

2. Make sure all the Ink Out B lights are off. 

3. To clean the black print head, press the B Cleaning button 
for three seconds.

To clean the color print head, press the A Cleaning 
button for three seconds.

Cleaning each head takes up to three minutes, during 
which the printer makes some noise and the Operate and 
Pause lights flash. 

4. After the cleaning cycle is complete and the Pause light 
stays on without flashing, you can repeat step 3 to clean the 
other print head, if you wish. Then you need to run a 
nozzle check to test the print quality and reset the cleaning 
cycle.

5. Access the Main printer settings dialog box as described in 
Chapter 1.

6. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

7. Click the Nozzle Check icon, then click Next. See the next 
section for instructions on examining the nozzle check 
pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this four or five 
times, check the print quality solutions in Chapter 6.

Note:
If any Ink Out lights 
are flashing or on, you 
need to replace the ink 
cartridge instead. See 
page 5-4 for instructions.

If you were printing when 
you started cleaning the 
print heads, the Pause 
light may still be on. Press 
the Pause button to turn 
off the light and resume 
printing.

Caution:
Never turn off the printer 
while the Pause light is 
flashing.

If, however, the Pause 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making any noise, you 
may turn off the printer. 
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this, with the lower pattern colored cyan, 
magenta, and yellow:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps or deflections (oversprayed dots of ink). 
You may need to use a magnifying glass or loupe to examine the 
printout in detail.

If your printout looks okay, you’re done. If any dots are missing 
or deflected, clean the print heads again, as explained in the 
previous sections.

Replacing an Ink Cartridge
When an Ink Out B light flashes, the indicated cartridge is low 
on ink. This is a good time to make sure you have a new 
cartridge. When the light stays on, the cartridge is empty and 
you need to replace it.

Use EPSON ink cartridges within six months of installing them 
and before the expiration date on the package:

Black ink cartridge S020118
Cyan ink cartridge S020130
Magenta ink cartridge S020126
Yellow ink cartridge S020122

When you need new ink cartridges, contact your dealer, call 
EPSON at (800) 873-7766, or visit www.epsonstore.com. (U.S. 
only). In Canada, please call (800) 463-7766 for dealer referral.

W01372 C01267

Caution:
For best results, don’t 
replace an ink cartridge 
unless its Ink Out light is 
flashing or on.

If you remove an ink 
cartridge and reinstall 
it, the printer cannot 
correctly determine the 
level of ink and the Ink 
Out light may not come 
on when the cartridge 
runs out of ink.

To ensure good results, 
use genuine EPSON 
cartridges and do not refill 
them. Other products may 
cause damage to your 
printer not covered by 
EPSON’s warranty.
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Removing and Installing an Ink Cartridge

You should replace an ink cartridge only when its Ink Out B 
light is flashing or on. 

1. Make sure the printer is turned on and not printing. 

2. Open the ink cartridge compartment by pushing the top of 
the ink compartment door. You see four slots for the ink 
cartridges. 

3. Carefully pull the used ink cartridge straight out of the 
printer.

4. Make sure the replacement ink cartridge is the correct 
color; then remove it from its packaging. 

5. Insert the ink cartridge into the slot with the foil plug end 
first and the arrow pointing toward the printer. Push the 
cartridge all the way into its slot until it meets resistance. 

The Ink Out light turns off. If it remains on, pull the ink 
cartridge partly out of its slot and reinsert it. 

6. Close the ink compartment door. 

Caution:
Leave the empty cartridge 
installed in the printer until 
you are ready to replace it. 

Once you remove an ink 
cartridge, it becomes 
unusable and cannot be 
reinstalled.

Warning:
If ink gets on your hands, 
wash them thoroughly with 
soap and water. If ink gets 
into your eyes, flush them 
immediately with water.
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Printing in Black Ink With an Empty Color 
Cartridge

If a color ink cartridge runs out of ink and its Ink Out B light 
comes on, you can still continue printing with black ink. (If the 
black ink cartridge runs out of ink, you cannot continue 
printing.) However, you will need to resend any print job you 
were printing when the color ink ran out. Follow these steps:

1. Turn off the printer.

2. Wait about five seconds and then turn the printer back on 
again. Don’t remove the empty color ink cartridge.

3. If there is paper in the paper path, press the Load/Eject 
button to eject it or to advance continuous paper to the 
tear-off edge. Tear off any continuous sheets and press 
Load/Eject again to park the continuous paper out of the 
path.

4. Access the printer software in your application as described 
in Chapter 1. Change the Ink setting for your document to 
Black and change any other settings as necessary. Then 
print the document.

To switch back to color printing, follow the steps beginning on 
page 5-5 to replace the color ink cartridge. Then turn the 
printer off and on again to reset color printing mode. Before 
you print, be sure to set the Ink setting to Color in your printer 
software as described in Chapters 1 and 2.

Caution:
If you’re printing on 
continuous label paper, 
don’t press Load/Eject; 
this feeds the paper 
backward and may cause 
labels to tear off inside 
the printer. Follow the 
steps on page 3-19 
instead.
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Aligning the Print Heads
If your printouts contain misaligned vertical lines, you may 
need to align the print heads. There are several ways to do this:

◗ You can use the print head alignment utility in your printer 
software, as described below.

◗ You can also use the control panel to align the print heads. 

Use one of the utilities if your printer is connected directly to 
the computer. Use the control panel if your printer is connected 
via an optional network interface card.

Using the Print Head Alignment Utility

1. Make sure the printer is turned on and paper is loaded in 
the paper tray (see page 3-7 for instructions).

2. Access the Main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print an alignment 
test page and select the correct alignment.

Caution:
Load paper that’s at least 
8.3 inches (210 mm) wide 
so ink doesn’t spray onto 
the platen.
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Using the Control Panel

1. Load several sheets of paper at least 8.3 inches (210 mm) 
wide in the paper tray. 

2. Move the paper-release lever backward to the single sheet 
position.

3. Turn off your printer.

4. Hold down the Pause button and turn on the printer to 
turn on print head alignment mode. Be sure to hold down 
both buttons for three seconds before releasing them.

The printer loads a sheet of paper and prints an instruction 
sheet telling you how to select a language (the default 
setting is English). The printer can then print instructions 
on aligning the print heads in the language you choose.

5. Press the Micro Adjust U button until the Ink Out B 
Yellow and Ink Out B Magenta lights on your control 
panel indicate the language you want to use.

Language Lights

English Both lights off

French Ink Out B Yellow on and Ink Out B Magenta off

German Ink Out B Yellow flashing and 
Ink Out B Magenta off

Italian Ink Out B Yellow off and Ink Out B Magenta on

Spanish Both lights on

Portuguese Ink Out B Yellow flashing and 
Ink Out B Magenta on
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6. Press the Pause button. The printer prints instructions on 
aligning the print heads using the control panel.

7. Follow the instructions on the sheet. When the print heads 
are aligned, turn off the printer to exit print head alignment 
mode.

8. After five seconds, turn on the printer to resume printing.

Cleaning the Printer
To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove the paper from all the paper feeders.

3. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

4. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Transporting the Printer
If you want to ship your printer, you need to prepare it for 
transportation and repack it in the original box. Follow these 
steps:

1. Turn on the printer.

2. Remove all four of the ink cartridges and store them in 
separate plastic bags. 

3. Close the ink compartment door.

Caution:
Don’t touch the gears 
inside the printer.

Never use alcohol or 
thinner for cleaning; they 
can damage the printer 
components and case.

Don’t use a hard or 
abrasive brush.

Don’t get water on the 
printer components.

Don’t spray lubricants or 
oils inside the printer.
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4. Turn off the printer and make sure the print heads are in 
the home (far right) position. If they are not, turn the 
printer back on, wait until they stop moving and are in the 
home position, then turn off the printer.

5. Wait until the printer stops making noise and any lights 
stop flashing, then unplug the power cord from the 
electrical outlet and disconnect the interface cable from the 
printer.

6. Remove the paper from all the feeders.

7. Remove the edge guides and banner paper cover.

8. Remove the paper tray and paper tray cover.

9. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Notice Sheet that was packed with the printer.

Be sure to keep the printer level in an upright position as you 
transport it. 

If you reinstall the cartridges that were removed in step 2, the 
ink sensor will not correctly indicate the amount of ink in the 
cartridges. You may run out of ink before the Ink Out lights 
flash or come on. If you want the ink sensor to work properly, 
you need to install new ink cartridges. See page 5-4 for 
instructions.

If you notice a decline in print quality after transporting the 
printer, clean the print heads; if output is misaligned, align the 
print heads. See the instructions earlier in this chapter.

Caution:
If you don’t follow the 
procedures in this 
section, ink will leak 
when you transport the 
printer. 

However, if you are 
moving your printer a 
short distance, for 
example, from one table 
to another, you don’t 
need to remove the ink 
cartridges. Be sure to 
keep the printer level 
when you move it.
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6
As you use your printer, you may occasionally experience a 
paper jam or other problem. The first thing you should do is 
diagnose the problem following the guidelines in this chapter. 
Then try the most likely solutions until the problem is fixed. 

This chapter tells you everything you need to know about the 
following:

◗ Diagnosing problems

◗ Improving print quality

◗ Solving printing problems

◗ Fixing paper jams and other paper problems

◗ Solving miscellaneous printout problems

Diagnosing Problems
Your printer includes a number of ways to help you diagnose 
problems:

◗ To identify the most common problems, check the lights 
on the printer’s control panel. See page 1-13 for 
instructions.

◗ You can also use the Status Monitor utility to identify 
common problems. For instructions, see page 4-4 
(Windows) or page 4-8 (Macintosh).

◗ To determine whether the problem is caused by the printer 
itself, run a printer self test. See the next section for 
instructions.

Troubleshooting
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◗ If you’re experienced with reading hexadecimal code, you 
can print a hex dump to identify possible communication 
problems. See page 6-3 for instructions.

◗ For the latest information, check the EPSON Stylus 
COLOR 3000 Help program and the ReadMe file in the 
EPSON program group or folder. 

◗ If none of the suggested solutions in this chapter solve your 
problem, contact EPSON as described under “Where to Get 
Help” in the Introduction.

Running a Self Test

You can run a printer self test to determine whether the 
problem lies with the printer itself or some other source. 

◗ If the test results are satisfactory, the problem lies in your 
computer or its printer port, the interface cable, or your 
software settings.

◗ If the test pages don’t print correctly, you may have a 
problem with your printer. See the suggestions in this 
chapter for possible solutions.

Follow these steps to test the printer:

1. Load several sheets of paper in the paper tray.

2. Turn off the printer.

3. Hold down the LF/FF button and press the POperate 
button to turn on the printer. Then release both buttons. 
This prints the test pages at 360 dpi. (If the test pages don’t 
print, turn off the printer. Repeat the button sequence, but 
hold down both buttons for several seconds before releasing 
them.) 

Caution:
Use paper that’s at least 
8.3 inches (210 mm) 
wide. Otherwise the print 
head will spray ink directly 
onto the platen.
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The first page prints on the first and last lines to measure 
the page length. The next page contains a nozzle check 
pattern and multicolored character samples. 

To print test pages at 180 dpi, hold down the Load/Eject 
button while turning on the printer instead of LF/FF. The 
180-dpi self test prints in black.

4. After the second page prints, press the Pause button to 
stop printing. 

5. If the printer loaded any additional paper, press Load/Eject 
to eject it. Then turn off the printer to end the test.

Improving Print Quality
You can often improve print quality by doing the following:

◗ Clean the print heads (see Chapter 5 for instructions).

◗ Use higher quality paper appropriate for your print job (see 
Chapter 3 for a list of EPSON papers).

◗ Match the Media Type setting in the printer software to 
the type of media you loaded in the printer (see Chapter 3 
for details).

◗ Make sure the thickness lever is set to the correct position 
for your media (see Chapter 3 for details).

◗ Turn off High Speed mode in the printer software (see 
Chapter 2 for details).

◗ Make sure you’re not using an Economy option in the 
printer software (see Chapter 2 for details).

◗ Replace the ink cartridges. (Check the status of the 
Ink Out B lights first. See Chapter 5 for instructions.)

Caution:
Never turn off the printer 
while it is printing. To 
end the test, always 
press the Pause button, 
eject any loaded paper, 
then turn off the printer.
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Here are some detailed solutions to specific print quality 
problems.

Printed image has horizontal banding.

Vertical lines are misaligned or vertical banding appears.

The printed image has incorrect or missing colors.

Possible cause Solution

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 through 3.

The printable side of the 
paper is loaded upside 
down.

Remove the paper and reload it correctly for the media and feeder 
you’re using. See Chapter 3 for instructions.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ink cartridges are low 
on ink.

Check the Ink Out B lights to see which cartridge you need to 
replace. See Chapter 5.

The MicroWeave option is 
not set.

Turn on MicroWeave in the printer software. See Chapter 2 for 
more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

High Speed mode or Bi-D 
mode are turned on.

If vertical lines are misaligned, turn off High Speed mode in the 
printer software (see Chapter 2 for information). 

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5.

Possible cause Solution

The Ink option is set to 
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 through 3.

The printable side of the 
paper is loaded upside 
down.

Remove the paper and reload it correctly for the media and feeder 
you’re using. See Chapter 3 for instructions.
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The printed image is faint or has gaps.

The Halftoning and Color 
Adjustment Mode options 
are set incorrectly for your 
document type.

Use the correct settings for the project you are printing, following 
the instructions in Chapter 2.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ICM (Windows) or 
ColorSync (Macintosh) 
settings are incorrect for 
your document.

Use the Automatic mode setting or choose a different project 
type setting. See Chapter 2 for more information.

The ink cartridges are low 
on ink or empty.

Check the Ink Out B lights to see which cartridge you may need to 
replace. See Chapter 5 for instructions.

The colors displayed on 
your monitor don’t match 
the printed colors.

Because your monitor and printer use different technologies to 
represent colors, your printed colors cannot exactly match those 
on your monitor screen. Use the ICM (Windows) or ColorSync 
(Macintosh) settings. See Chapter 2 for more information.

The color settings in your 
application software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 through 3.

The loaded paper is upside 
down, damaged, old, or 
dirty.

Remove the paper and reload a new stack with the printable side 
facing correctly. See Chapter 3 for instructions.

The ink cartridges are low 
on ink.

Check the Ink Out B lights to see which cartridge you may need to 
replace. See Chapter 5 for instructions.

An ink cartridge is out of 
ink.

If you replaced an ink cartridge before its ink out light came on, the 
ink sensor was incorrectly reset. Replace the empty ink cartridge 
with a new ink cartridge. See Chapter 5 for instructions. This 
resets the ink sensor.

Possible cause Solution
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The printed image is blurry or smeared.

You’re on a network and 
the Network I/F setting is 
turned off.

Try turning on the Network I/F setting using default-setting mode 
to see if this solves the problem. See page B-8 for instructions. 

You’re using Economy 
mode.

Turn off Economy mode. Economy mode is for printing drafts only.

Possible cause Solution

The printer’s thickness 
lever is in the 0 position.

Set the thickness lever to the + position and try printing again. See 
Chapter 3 for instructions.

The paper is damp or the 
printable side is upside 
down.

Remove the paper and reload a new stack with the printable side 
facing correctly. See Chapter 3 for instructions.

You loaded special media 
without a support sheet.

Follow the special media loading instructions in Chapter 3 and on 
the paper packaging for media that require support sheets. Also try 
loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended media.

Make sure your paper or media meets the specifications listed in 
Appendix B. If your printouts are still blurry after you change paper, 
clean the print heads as described in Chapter 5.

The Media Type setting 
does not match the loaded 
paper.

Make sure the Media Type setting matches the media you loaded. 
Then the printer software can automatically select other settings 
for the best quality. See Chapters 1 through 3 for information.

The sheets entering the 
output tray are smearing 
the ink on ejected pages.

Remove each sheet from the output tray as soon as it is printed to 
prevent smearing, especially if you use transparencies. 

Ink has leaked inside the 
printer.

Clean carefully inside the printer to remove spilled ink. See 
Chapter 5 for instructions.

A color ink cartridge is 
empty and you’ve 
continued printing with the 
Ink option set to Color.

Follow the instructions on page 5-6 to print in black ink with an 
empty color cartridge. Then replace the color ink cartridge 
following the instructions in Chapter 6.

You’re using the High 
Speed (or BiD) and 
MicroWeave settings with 
a misaligned print head.

Turn off High Speed mode following the instructions in Chapter 2. 
Then align the print heads following the instructions in Chapter 5.

Possible cause Solution
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Photographic images look grainy or rough.

Color documents print in black ink only.

Solving Printing Problems
If the printer won’t print, first check that:

◗ The printer is turned on and the Operate light is on.

◗ Paper is loaded in the printer.

◗ The printer is plugged securely into a working electrical 
outlet that’s not controlled by a switch or timer.

◗ The interface cable is securely connected to the printer and 
computer and both are turned on. 

Possible cause Solution

The print heads are 
misaligned.

Align the print heads following the instructions in Chapter 5.

The resolution of your 
image may be too low.

Increase the image resolution using your image-editing software, 
or decrease the size of the image.

Possible cause Solution

Your printer is not selected 
in your application.

Select your printer and port in your software application.

Color printing is not 
selected.

Select color printing in your application and the printer driver.

A color ink cartridge is 
empty.

Check the Ink Out B lights and replace the color cartridge, if 
necessary. See Chapter 5 for instructions on replacing ink 
cartridges and printing with an empty color cartridge.
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If you still can’t print, check the following solutions.

All lights are off.

Only the Operate light is on, but nothing prints.

Possible cause Solution

The printer is not receiving 
power.

Turn off the power and plug in the power cord securely.

Possible cause Solution

The interface cable is not 
connected securely or 
does not meet both the 
printer and computer 
specifications.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets both the printer and computer 
specifications. For printer specifications, see Appendix B. For 
computer specifications, see your computer documentation.

The printer has an internal 
problem.

Turn off the printer and computer, disconnect the interface cable, 
and run a printer self test as described on page 6-2.

Your printer or application 
software is installed 
incorrectly.

If the self test prints correctly, check your printer and application 
software for correct installation. If you’re printing on a network, 
make sure you set up your printer as described in Chapter 4.

Your computer doesn’t 
have enough memory to 
handle the data in the file 
you are printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Printing is stalled in 
Spool Manager 
(Windows 95/98/Me) or the 
Windows NT print queue.

Delete the stalled print jobs in Spool Manager or the Windows NT 
print queue and resume printing. See Chapter 4 for instructions.

Printing is stalled in 
Monitor2 (Macintosh).

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files.

The print heads are clogged 
or the ink cartridges are too 
old.

If the printer sounds like it’s trying to print but doesn’t print 
anything, clean the print heads; see Chapter 5 for instructions.

If cleaning doesn’t help, replace the cartridges. For information on 
cartridge life and replacement instructions, see Chapter 5.

You’re using an 
incompatible optional 
interface board or one with 
mismatched settings.

Check the specifications for your interface board and cable, making 
sure they match your computer’s settings (see your computer 
manual). Also make sure the Network I/F setting is turned on in 
default-setting mode (see page B-8). 
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The Paper Out light is flashing or on.

An Ink Out B light is flashing or on.

All the lights come on briefly, then go off.

All the lights are flashing.

Possible cause Solution

If flashing, paper is 
jammed.

Remove the paper and follow the guidelines for preventing jams 
on page 6-16.

If on, paper is not loaded or 
is loaded incorrectly.

Load paper or remove the stack and reload it as described in 
Chapter 3. Then press the Load/Eject button to turn off the light 
and resume printing.

If on, the paper-release 
lever is set incorrectly for 
the paper you loaded.

Set the paper-release lever forward for continuous tractor-fed 
paper or backward for single sheets. See Chapter 3 for more 
information.

Possible cause Solution

If flashing, the ink supply is 
getting low.

You need to replace the indicated ink cartridge soon. Make sure 
you have a new cartridge, then see Chapter 5 for instructions.

If on, the ink cartridge is 
empty.

You must replace the indicated ink cartridge; see Chapter 5 for 
instructions.

Possible cause Solution

The printer’s voltage 
doesn’t match your outlet’s 
voltage.

Check the label on the back of your printer to determine its 
voltage. If it doesn’t match your outlet’s voltage, turn off the 
printer and unplug it immediately. Then contact your dealer. 
Do not plug the printer back in.

Possible cause Solution

An internal error may have 
occurred. 

Turn off your printer, wait five seconds, and turn it on again. If the 
lights still flash or stay on, contact EPSON as described in the 
Introduction.
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The printer has finished charging an ink cartridge, but the Pause light is still 

flashing.

The printer sounds like it’s printing but nothing prints.

The printer software installed with an earlier version of Windows does not work 

correctly after you upgrade.

After you install your printing software, you see the Windows New Hardware 

Found window.

Possible cause Solution

The printer needs to 
initialize.

If the light is still flashing after 10 minutes and printer is not 
moving or making noise, turn the printer off. If the light is still 
flashing when you turn it back on, contact EPSON as described in 
the Introduction.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ink cartridges are too 
old.

For information on cartridge life and replacement instructions, see 
Chapter 5.

An ink cartridge is out of 
ink.

If you replaced an ink cartridge before it’s ink out light came on, the 
ink sensor was incorrectly reset. Replace the empty ink cartridge 
with a new ink cartridge. See Chapter 5 for instructions. This 
resets the ink sensor.

Possible cause Solution

Your printer software is not 
set up correctly for your 
operating system.

Reinstall the printer software after upgrading your operating 
system, as described in the Quick Setup booklet.

Possible cause Solution

An operating system error 
has occurred.

Click Cancel.

You connected the 
USB-parallel cable before 
installing the software.

Follow the instructions on the Quick Setup booklet to install the 
printer driver with the USB-to-parallel cable adapter. 
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You see a spooling error message (Windows).

You don’t see the ink status information in the Despooler window after you print 

(Windows).

You see a memory error message (Macintosh).

A portion of your image doesn’t print (Macintosh).

Possible cause Solution

Spooling error messages or 
very slow printing may be 
caused by temporary files.

Change the Spool Manager default directory, following the 
instructions in Chapter 4.

Your hard drive is too full. Delete unnecessary files to make room on the drive.

Your computer doesn’t 
have enough memory for 
the file you’re printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Possible cause Solution

You are using Windows 98 
or Me and connecting to the 
printer through a USB port 
or through a network.

Ink status information is not available in Windows 98 or Me when 
you connect through a USB port or network. You can either switch 
to the parallel port or upgrade your Windows operating system. 
You will also need to uninstall and reinstall the printer driver.

Possible cause Solution

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor3, or both.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor3).

Possible cause Solution

Your system doesn’t have 
enough available memory.

Close any other applications you are running or turn off 
background printing.

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor3, or both.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor3).
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Printing is too slow.

Your printer switches to the modem port or won’t confirm on the printer port 

(Macintosh). 

Your printer icon doesn’t appear in the Chooser (Macintosh).

Possible cause Solution

Your printer software 
options are set incorrectly.

For the fastest printing, try the following:
◗ Set Print Quality to Economy.
◗ Turn High Speed on.
◗ Choose No Halftoning.
◗ Choose Black ink.
See Chapters 1 and 2 for more information.

Your system doesn’t have 
enough resources.

◗ Reduce the resolution of your image.
◗ Clear space on your hard disk drive or run a defragmentation 

utility.
◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM).

You’re using background 
printing on a Macintosh.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor3).

Your Spool Manager 
settings are incorrect 
(Windows 95/98).

Change your default spool directory and other settings as 
described in Chapter 4.

Possible cause Solution

Your system has extension 
conflicts.

Make sure AppleTalk is inactive. In the Extensions Manager, 
disable the AppleShare, FileShare, and PrinterShare extensions. 
Set your printer and any unused printers to the printer port. Then 
restart your system.

You’re using an AppleTalk 
cable.

Make sure you’re using a standard Apple System Peripheral-8 
cable. See Appendix B for specifications.

Possible cause Solution

Your system has extension 
conflicts.

In the Extensions Manager, disable Quick Draw GX. Make sure 
EPSON Monitor3 and EPSON Stylus Color are enabled, then 
restart your Macintosh. 
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The “Sorry, EPSON Stylus COLOR cannot be used” message appears (Macintosh).

You turned the printer on and it is making noise.

Fixing Paper Problems
You can avoid most paper handling problems by doing the 
following:

◗ Use smooth, high-quality media designed for ink jet 
printers that meet the media specifications in Appendix B.

◗ Make sure the paper is dry and flat before loading it.

◗ Follow all loading and handling instructions included with 
the media and in Chapter 3.

Possible cause Solution

The printer driver has been 
corrupted.

Remove and reinstall the driver: 

1. Insert the printer software CD-ROM in your drive. If necessary, 
double-click the EPSON CD-ROM to open its window. Then 
double-click the  EPSON icon.

2. Double-click Install Printer Driver for EPSON Stylus Color 
3000.

3. At the next screen, click Continue. Then click Easy Install and 
select Remove from the pop-up list.

5. Click Remove. After the driver has been removed, click OK. 

6. See the Quick Setup booklet for instructions on installing the 
printer driver. 

7. In the Extensions Manager, disable Quick Draw GX. 

8. Make sure EPSON Monitor3 and EPSON Stylus Color are 
enabled, then restart your Macintosh.

Possible cause Solution

The printer is charging the 
print heads.

Wait until the printer finishes charging the print heads before you 
print. If the printer has been turned off for a while (for example, 
over the weekend), it needs to charge the print heads before 
printing. This can take up to 10 minutes; do not turn off the printer 
while the print heads are charging.
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If you have problems with paper feeding, paper jams, or ejected 
paper, check here for solutions.

Paper doesn’t feed correctly from the paper tray.

Paper doesn’t feed correctly from the manual feeder.

Try this Then do this

Remove the stack of paper 
from the paper tray.

Check that the paper:
◗ Isn’t curled or creased.
◗ Isn’t too thick or thin (see Appendix B).
◗ Isn’t too old (see Chapter 3 or your paper packaging).
◗ Isn’t overloaded in the feeder (see Chapter 3 for guidelines).
◗ Isn’t jammed inside the printer. (If the Paper Out light is 

flashing, paper is jammed. See page 6-16.)
Then reload the paper as described in Chapter 3, making sure that:
◗ The paper-release lever is set back to the single sheet position.
◗ The edge guides fit the paper’s width snugly, without any 

slack.
◗ The rear edge guide fits the paper’s length.
◗ The paper tray and paper tray cover are fully extended if you 

are printing on oversized paper.
◗ No continuous paper is in the paper path. (Press Load/Eject to 

park it out of the way.)

Try this Then do this

Remove the paper from the 
manual feeder.

Check that the paper:
◗ Isn’t curled or creased.
◗ Isn’t too thick or thin (see Appendix B).
◗ Isn’t too old (see Chapter 3 or your paper packaging).
◗ Isn’t jammed inside the printer. (If the Paper Out light is 

flashing, paper is jammed. See page 6-16.)
Then reload the paper as described in Chapter 3, making sure that:
◗ The paper-release lever is set back to the single sheet position.
◗ The edge guides fit the paper’s width snugly, without any 

slack.
◗ The paper is loaded all the way into the manual feed slot.
◗ No continuous paper is in the paper path. (Press Load/Eject to 

park it out of the way.)
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Paper doesn’t feed correctly from the tractor feeder.

Multiple pages feed at the same time.

Try this Then do this

Remove the continuous 
paper from the tractor 
feeder following the 
instructions on page 3-19.

Check that the paper:
◗ Isn’t curled or creased.
◗ Isn’t too thick or thin (Appendix B).
◗ Isn’t too old (see Chapter 3 or your paper packaging).
◗ Isn’t jammed inside the printer. (If the Paper Out light is 

flashing, paper is jammed. See page 6-16.)
Then reload the paper as described in Chapter 3, making sure that:
◗ The paper-release lever is set forward to the continuous paper 

position.
◗ The paper stack is close enough to the printer, but has room in 

front and back to load and eject without obstruction.
◗ The paper’s holes are aligned on the sprockets, the sprockets 

are locked and their covers are closed, and the paper is not too 
slack.

◗ No single sheet paper is in the paper path. (Press Load/Eject to 
eject any sheets.)

Before printing, check that:
◗ The paper source and paper size are set correctly in your 

application or printer software.)
◗ The skip over perforation, auto tear-off, and banner modes are 

set correctly for your media (see Appendix B). 

Try this Then do this

Remove the stack of paper. ◗ Make sure the paper isn’t too thin (see the paper specifications 
in Appendix B).

◗ Fan the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in Chapter 3, making sure to 

load only the amount of paper directed for your media and 
feeder.

◗ If more copies of a page or document are printing than you 
expected, check that the Copies settings in both the printer 
software and your application program are set to 1. See 
Chapters 1 and 2 for information.
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Paper jams inside the printer.

Paper doesn’t eject fully or is wrinkled.

Try this Then do this

Turn off your printer, open 
the cover, remove any 
loaded paper, and remove 
any little pieces that may 
have torn off inside. 

You may need to turn the knob on the left side of the printer 
counterclockwise to eject all the torn pieces of paper. Never turn 

this knob when the printer is on. You’ll lose the top-of-form 

position and may damage the printer. If you were printing labels, 
make sure there are no labels or adhesive stuck inside.

Then reload the paper as described in Chapter 3.

If your paper jams frequently, make sure you:
◗ Use smooth, high-quality paper, with the printable side loaded 

correctly for your media type and feeder.
◗ Fan the stack and then even the edges before loading it.
◗ Don’t load too much paper for your media type and feeder.
◗ Adjust the edge guides or sprockets to fit the width of your 

paper snugly, but without too much slack.

Possible cause Solution

If the paper doesn’t eject 
fully, you may have set the 
wrong paper size.

Press the Load/Eject button to eject the paper. Then make sure 
you select the correct paper size in your application software, 
printer software, or default-setting mode. (See the paper 
specifications in Appendix B for the paper sizes you can print with.)

If it’s wrinkled when it 
comes out, the paper may 
be damp or too thin.

See the paper specifications in Appendix B for paper thicknesses 
you can print with, as well as environmental requirements for 
storage.
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Solving Miscellaneous Printout 
Problems
If your printout results are not what you expected, try these 
solutions.

Characters are incorrect or garbled.

.

The margins are incorrect.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup 
booklet for instructions.

Printing is stalled in Spool 
Manager (Windows 95/98) 
or in the Windows NT print 
queue.

Delete the stalled print jobs in Spool Manager or the Windows NT 
print queue following the instructions in Chapter 4. Then try 
printing again.

If you’re using background 
printing on a Macintosh, 
spooled data may be 
corrupted.

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files. Increase the memory requirements for 
EPSON Monitor as described in Chapter 4.

The interface cable is not 
securely connected.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications.

The printer’s parallel 
interface transfer rate 
doesn’t match your 
computer’s transfer rate.

Make sure your computer and printer’s Parallel I/F transfer rate are 
the same. Set the printer’s transfer rate using default-setting 
mode. See Appendix B for instructions. If you are not sure what 
settings to use, try setting both to Normal.

Possible cause Solution

Margins are set incorrectly 
in your software 
application.

Check your software documentation for instructions on selecting 
the correct margins for your paper size. The maximum printable 
width is 16.3 inches (416 mm) on any size paper.

Make sure the margins are within the printable area of the page. 
See Appendix B for more information.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapters 1 and 2 for more information.
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The image is inverted as if viewed in a mirror.

The printer prints blank pages.

Possible cause Solution

You used a Flip Horizontal 
option in your application 
software or the printer 
software.

Turn off the Flip Horizontal or mirror setting in your application 
software or the printer software. See Chapter 2 for more 
information. 

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads following the instructions in Chapter 5.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapters 1 and 2 for more information.

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup 
booklet for instructions.
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A
You can use the EPSON Plot! utility to open and scale HPGL or 
HPGL/2 plotter files and then print them on your printer. 
Follow the instructions in this Appendix to install the program 
and print with EPSON Plot! and your Windows printer driver.

You can install and use EPSON Plot! on any system running 
Windows. Make sure to connect the printer to that system and 
install the printer software following the instructions in the 
Quick Setup booklet before you begin.

Installing EPSON Plot!
Follow these steps to install EPSON Plot! on the system 
connected to the printer:

1. Make sure Windows is running, but no applications are 
open.

2. Insert the EPSON Plot! CD-ROM in a drive.

3. Click Start, then click Run.

4. Type D:\SETUP (where D is the letter of your CD drive 
and click OK.

5. Follow the instructions on the screen to install the program 
on your hard disk.

The installation program creates an EPSON Plot! program 
group or folder containing the program icon and icons for 
Help, Readme, and Uninstall programs.

Using
EPSON Plot!
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Printing With EPSON Plot!
Before starting EPSON Plot!, do the following to prepare for 
printing:

◗ Install the EPSON Stylus COLOR 3000 Windows printer 
software on the computer connected to the printer. (See the 
Quick Setup booklet for instructions.)

◗ Turn on the printer.

◗ Create an HPGL or HPGL/2 plot file using your plotter 
software on any system.

◗ Copy that plot file to the system connected to the printer, if 
necessary.

Now follow these steps to open EPSON Plot! and print:

1. Double-click the EPSON Plot! icon in the EPSON Plot! 
program group or folder. You see the following screen:

2. Select Open File from the File menu.

3. In the Open File dialog box, choose the HPGL or HPGL/2 
file you want to print and click OK. A representation of the 
file contents appears in the Live Paper Space in EPSON 
Plot!:

Note:
When you create plot 
files for printing, use an 
HPGL/2 driver whenever 
possible. HPGL/2 drivers 
do a better job of 
maintaining the colors 
assigned in your CAD 
application than HPGL 
drivers, which may limit 
you to 8 or 16 pen colors.
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4. Select Printer Setup from the File menu.

5. Select the EPSON Stylus COLOR 3000 printer, if necessary, 
and click Options. You see the Main printer settings menu.

6. Follow the instructions in Chapters 1 and 2 to select the 
correct printer settings. Make sure to select the Paper 
Source and Paper Size options for your paper and feeder 
so EPSON Plot! can display the plot file contents exactly as 
it will appear when you print. 

7. When you’re finished selecting your printer software 
settings, click OK. Then click OK in the Print Setup dialog 
box. 

8. If you want to resize the plot file, click a handle in the Live 
Paper Space and drag it to change the size. To reposition 
the plot, click inside the image display and drag it into 
position.

9. When the plot file looks how you want it to, select Print 
from the File menu.

10. Click OK to print the file on your EPSON Stylus COLOR 
3000.

live paper 
space

handle

Note:
The gray area around the 
image represents the 
area you cannot print on.

If you resize the plot
file, EPSON Plot! retains 
the proportions of the 
original and preserves 
the X and Y coordinates.

If you print at 720- or 
1440-dpi, you need to 
rescale your image. 
Otherwise it will print 
smaller than what is 
shown in the Live Paper 
Space.
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See Chapters 1 and 4 for information on managing the 
print job while it prints. 

11. When you’re finished printing with EPSON Plot!, select 
Exit from the File menu to exit the program.
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B

Printing
Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 128 nozzles 
Color (cyan, magenta, yellow) 192 nozzles, 64 of each color

Printable columns and 
printing speeds

Resolution Maximum 1440 dpi × 720 dpi

Print direction Bidirectional with logic seeking for text and graphics. (Auto print 
direction can be set in the default-setting mode.)

Control code ESC/P 2 and expanded raster graphics code
IBM XL24E

Line spacing 1/6 inch (default), programmable in 1/8-inch and 1/360-inch 
increments

Paper feed speed 100 milliseconds per 1/3-inch line 

Input buffer 64KB

Specifications

Character pitch 

(characters per inch) Printing column

Printing speed 

(characters per second)

Draft LQ

10 161 800 400

12 193 960 480

15 242 1200 600

17 (10 condensed) 276 1378 684

20 (12 condensed) 322 1600 800
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Fonts

cpi=characters per inch.

Note: 
The printer always uses the fonts you selected with your software application. You need to use the 
printer’s internal fonts only if your application doesn’t allow you to select fonts.

Character tables 1 italic and 26 graphics character tables

Character sets 14 international character sets and 1 legal character set

Note:
Character tables are selected with default-setting mode (see page B-8 for instructions).

Bitmap fonts
Font 10 cpi 12 cpi 15 cpi Proportional

EPSON Roman x x x x

EPSON Sans Serif x x x x

EPSON Courier x x x —

EPSON Prestige x x x —

EPSON Script x x x —

Scalable fonts

Font

Minimum 

point size

Maximum 

point size Increments

EPSON Roman 8 32 2

EPSON Sans Serif 8 32 2

EPSON Roman T 8 32 2

EPSON Sans Serif H 8 32 2
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Paper 

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
Legal (8.5 × 14 inches) 
Half Letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)
A2 (420 × 594 mm)
Super A3/B (13 × 19 inches)
A3 (297 × 420 mm)
Ledger (11 × 17 inches)
US C (17 × 22 inches)
B3 (364 × 514 mm)
B4 (257 × 364 mm)
B5 (182 × 257 mm)

Plain bond paper and 
special ink jet papers 
distributed by 
EPSON

0.0031 to 0.0059 inch 
(0.08 to 0.15 mm) 

Built-in sheet 
feeder:
17 to 24 lb 
(64 to 90 g/m2)
Manual feeder:
14 to 24 lb 
(52 to 90 g/m2)

Transparencies 
and Glossy film

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy 
film only)
Super A3/B (13 × 19 inches, 
glossy film only)

Transparencies and 
glossy film 
distributed by 
EPSON

0.005 to 0.006 inch 
(0.13 to 0.15 mm)

—

Glossy paper Letter (8.5 × 11 inches)
A2 (420 × 594 mm)
A4 (210 × 297 mm)

Glossy paper 
distributed by 
EPSON

0.0066 to 0.0070 inch 
(0.17 to 0.18 mm)

—

Photo quality 
Self adhesive 
sheets

A4 (210 × 297 mm) Self adhesive sheets 
distributed by 
EPSON

0.0079 inch (0.2 mm) 
maximum 

—

Envelopes No. 10 9.5 × 4.1 inches 
(240 × 104 mm) 

DL 8.7 × 4.3 inches 
(220 × 110 mm) 

C5 9 × 6.4 inches 
(229 × 162 mm)

Plain bond paper or 
air mail paper

0.006 to 0.02 inch 
(0.16 to 0.52 mm)

12 to 24 lb 
(45 to 90 g/m2)

Index (ink jet) 
cards

A6 (105 × 148 mm)
8 × 10 inches (203 × 254 mm)

Ink jet cards 
distributed by 
EPSON

0.0091 inch (0.23 mm)
maximum

50 lb 
(188 g/m2)

Banner paper 8.3 to 16.5 inches × 16.4 ft
(210 to 420 mm × 5 m)

Roll banner paper 
distributed by 
EPSON

0.003 to 0.004 inch
(0.08 to 0.1 mm)

17 to 22 lb
(64 to 82 g/m2)
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Note: 
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always 
test samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you 
encounter problems, switch to a higher grade of paper.

Ink jet paper, envelopes, glossy film, glossy paper, transparencies, self adhesive sheets, back light 
film, and canvas cloth are usable only under these conditions:

Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

EPSON Photo Quality Glossy Film and Photo Quality Self Adhesive Sheets should be stored under 
these conditions:

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Printable areas

Single sheets and 
index cards

A: The minimum top margin is 0.12 inch (3.0 mm).

BL: The minimum left margin is 0.12 inch (3.0 mm); except for A3 
landscape, A2 portrait, US B landscape, and US C portrait, which are 
0.2 inch (5 mm).

BR: The minimum right margin is 0.12 inch (3.0 mm); except for A3 
landscape and A2 portrait, which are 0.2 inch (5 mm), and US B 
landscape and US C portrait, which are 0.43 inch (11 mm).

C: The minimum bottom margin is 0.55 inch (14.0 mm).

Note:
The maximum printable width is 16.3 inches (416 mm) 
regardless of the paper size or feeder you use.

Paper type Size Paper types Thickness Weight

Continuous 
paper

Minimum size each sheet:
4 to 16 × 4 inches
(101.6 to 406.4 × 101.6 mm)

Plain paper 0.0025 to 0.0039 inch
(0.065 to 0.1 mm)

14 to 22 lb 
(52 to 82 g/m2)

Continuous label 
paper

Minimum size each backing 
sheet:
4 to 16 × 4 inches
(101.6 to 406.4 × 101.6 mm)
Minimum label size:
2.5 × 0.94 inches
(63.5 × 23.9 mm)

Plain continuous 
label paper

Maximum total 
thickness:
0.0079 inch (0.2 mm)
Maximum label 
thickness:
0.0047 inch (0.12 mm)

—

A

BL
BR

C
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Envelopes
A: The minimum top margin is 0.33 inch (8.5 mm).

BL, BR: The minimum left and right margins are 0.12 inch (3.0 mm).

C: The minimum bottom margin is 0.55 inch (14.0 mm).

Continuous paper

A: The minimum top and bottom margins above and below the 
perforations are 0.35 inch (9.0 mm).

B: The minimum right and left margins are 0.51 inch (13 mm).

Note:
The maximum printable width is 15 inches (381 mm).

Ink Cartridges

* The print capacity may vary, depending on how often you clean the print head.

** It thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON ink cartridges. Other products may cause damage 
to your printer not covered by EPSON’s warranty.

Don’t use an ink cartridge if the date on the package has expired.

A

C
BL BR

A A

BB

Specification Black (S020118) Cyan (S020130) Magenta (S020126) Yellow (S020122)

Print capacity* 3800 pages/A4 (ISO/IEC 
10561 Letter Pattern at 360 
dpi)

2100 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date, if unopened

Storage 
temperature

–22 to 104 °F (–30 to 40 °C)
1 month at 104 °F (40 °C)

Transit 
temperature

–22 to 122 °F (–30 to 50 °C)
1 month at 104 °F (40 °C)
120 hours at 122 °F (50 °C)

–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 122 °F (50 °C)

Freezing 
temperature**

3.2 °F (–16 °C) –1.3 °F (–18.5 °C) –5.8 °F (–21 °C) –0.4 °F (–18 °C)

Dimensions 2.0 (W) × 5.5 (D) × 4.2 (H) inches
25.1 (W) × 139.6 (D) × 105.3 (H) mm
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Mechanical
Paper feed method Friction, tractor feeder

Paper path Sheet feeder, front entry
Manual feeder, rear entry
Tractor feeder, rear entry

Sheet feeder capacity 100 sheets of 17 lb (64 g/m2) paper
For detailed information, see Chapter 3.

Total print volume 75,000 pages (A3, text only)

Dimensions

Width 31.9 inches (810 mm)

Depth 22.3 inches (565 mm) maximum 

Height 9.4 inches (240 mm)

Weight 37.8 lb (17.2 kg) without the ink cartridges

Electrical

Note: 

Check the label on the back of the printer for your printer’s voltage.

Environmental
Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 140 °F (–20 to 60 °C), stored in shipping container 
1 month at 104 °F (40 °C) 
120 hours at 140 °F (60 °C)

Humidity Operation: 20 to 80% RH
Storage: 5 to 85% RH (stored in shipping container, without 
condensation)

Specification 120V Model 220−240V Model

Input voltage range 103.5 to 132V 198 to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7A 0.4A

Power consumption Approx. 21W (ISO/IEC 10561 Letter Pattern)
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Safety Approvals
Safety standards UL 1950 with D3, CSA C22.2 950 with D3

EMC FCC part 15 subpart B class B

Interfaces
Parallel interface

Forward channel Data format: 8-bit parallel, IEEE-1284 compatibility mode

Synchronization: STROBE pulse

Handshake timing: BUSY and ACKNLG signals

Signal level: TTL compatible

Connector: 36-pin 57-30360 Amphenol connector or equivalent

Reverse channel Transmission mode: IEEE-1284 Nibble mode

Synchronization: Refer to the IEEE-1284 specification

Handshaking: Refer to the IEEE-1284 specification

Signal level: IEEE-1284 Level 1 device

Data transmission timing: Refer to the IEEE-1284 specification

Adaptable connector: 36-pin 57-30360 Amphenol Connector or 
equivalent

Serial interface

Standard: Based on RS-423

Synchronization: Synchronous

Bit rate: Maximum 1.8 Mbps

Handshaking: X-ON/X-OFF, DTR protocol

Word format: 
Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector: 8-pin mini-circular connector

Recommended cable: Apple System Peripheral-8 serial cable 
(preferably Belkin brand)
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Changing Printer Settings With 
Default-Setting Mode
Your printer includes internal default settings that are active 
whenever you turn on the printer. These settings control 
functions such as the print direction and paper loading 
positions. 

Because they are preset to the most likely settings you’ll want to 
use, you probably won’t need to change them. However, you 
may want to change settings such as these for special projects:

◗ Turn on auto tear-off mode when you print on continuous 
paper or roll paper (but not when printing continuous label 
paper)

◗ Turn on banner mode when you print on roll paper

◗ Select a slashed zero (0/) instead of a regular zero (0) when 
you print documents where the zero can easily be confused 
with a capital “O”

You can check or change the default settings using the printer’s 
control panel. Follow the steps in the next section.

Entering Default-Setting Mode

To enter default-setting mode and print an instruction sheet in 
one of six languages, follow these steps:

1. Load four or more sheets of paper at least 8.3 inches 
(210 mm) wide into the paper tray. See page 3-4 for 
loading instructions.

2. Turn off the printer.

Note:
The printer’s control panel 
buttons perform different 
functions while the printer 
is in default-setting mode. 
Be sure to carefully follow 
the instructions your 
printer prints and don’t 
try to perform standard 
control panel functions 
until you’ve exited 
default-setting mode.
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3. While holding down the Media Type button, press the 
Operate button to turn on the printer to enter 
default-setting mode. Hold down both buttons for three 
seconds, then release them.

The printer loads a sheet of paper and prints an instruction 
sheet telling you how to select a language (the default 
setting is English). 

4. If you want to print the default-setting instructions in 
another language, press the Micro Adjust U button until 
the Ink Out B Yellow and Ink Out B Magenta lights on 
your control panel indicate the language you want to use.

5. Press the Pause button. The printer prints instructions on 
changing the default settings.

6. Follow the instructions on the sheet to change the necessary 
settings, as listed in the next section. Your changes remain 
in effect until you change them again. (To exit without 
changing any settings, press the Pause button.)

7. When you’re finished changing settings, press Load/Eject 
if you need to eject any loaded paper. Then turn off the 
printer to exit default-setting mode.

8. Wait five seconds, then turn on your printer to resume 
printing.

Language Lights

English Both lights off

French Ink Out B Yellow on and Ink Out B Magenta off

German Ink Out B Yellow flashing and 
Ink Out B Magenta off

Italian Ink Out B Yellow off and Ink Out B Magenta on

Spanish Both lights on

Portuguese Ink Out B Yellow flashing and 
Ink Out B Magenta on
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List of Default-Setting Options

The table below lists all the options available for each default 
setting. The factory defaults are listed in bold type in the table 
below. The printer’s current settings are marked with a ⇐ on 
your printed instruction sheet.

Setting Options Description

Print direction Auto, Bi-D, Uni-D Auto switches between bidirectional printing for 
text data (the print head prints in both directions) 
and unidirectional printing for graphics data. For 
the fastest printing of text only, select Bi-D; but if 
vertical lines become misaligned, you’ll need to 
turn it off or align the print heads (see page 5-7 for 
instructions). For the most accurate alignment 
when printing graphics, select Uni-D.

Font Courier, Roman, 
Sans Serif, 
Prestige, Script, 
Roman T, Sans 
Serif H, Draft

If your software doesn’t let you select fonts, you 
can select one of these bitmap or scalable fonts. 

Pitch 10, 12, 15, 17.1, or 
20 cpi, or 
Proportional

If your software doesn’t let you select point size or 
characters per inch for your fonts, you can select 
one of these. 

I/F (interface) mode Auto, Parallel, 
Serial, Option

When your printer is connected to multiple 
interfaces, Auto sets the printer to receive data 
from any interface sending a print job. Select 
Parallel, Serial, or Option only if you want your 
printer to ignore print jobs sent from other 
interface types.

Auto I/F (interface) wait 
time

10 or 30 seconds If you choose Auto for the I/F mode setting, 
selects the time the printer waits for a print job 
from one interface before accepting a print job 
from another interface.

Software (emulation 
mode)

ESC/P 2, IBM 
XL24E

Specifies the control mode you want the printer to 
use. For the best font and graphics control, always 
use ESC/P 2 mode. If you need to emulate an 
IBM® Proprinter,™ select IBM XL24E mode. 
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Auto CR (IBM XL24E 
mode only)

Off, On In IBM XL24E mode, lets you select whether the 
printer performs a carriage-return line-feed 
operation when it reaches the right margin (On) or 
only when it receives a carriage-return code in the 
print job (Off).

AGM (IBM XL24E 
mode only)

Off, On In IBM XL24E mode, turns high resolution, 24-pin 
graphics command mode on or off.

Character table — The default character table is PC437.

International character 
set for Italic table

— The default character set is Italic U.S.A.

Auto line feed Off, On Sets the printer to either perform a line-feed 
operation every time it receives a carriage-return 
command (On) or not to perform one (Off).

Network I/F (interface) 
mode

Off, On Sets whether the printer is (On) or is not (Off) 
shared by more than one computer.

0 slash 0, 0/ Selects either a slashed zero (0/ ) or a regular 
zero (0) to be printed when a zero command is 
received.

Page length for 
continuous paper

11, 12, 8.5, or 70/6 
inches or Other

When printing on continuous paper, select the 
length of the individual sheets. 70/6 is the length 
of A4-size paper.

Skip over perforation Off, On If your software doesn’t let you set top and 
bottom margins, turn this setting On to add a 
one-inch margin over the perforation to separate 
text on continuous pages.

Auto tear off Off, On When printing on continuous paper or banner 
paper, turn this setting On to advance the 
perforation or end of the sheet to the printer’s 
tear-off edge. It also backs the paper up to the 
top-of-form position when it receives the next 
print job. Turn this setting Off when printing on 
continuous labels so they don’t tear off inside the 
printer.

Setting Options Description
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Banner mode Off, On When you turn this mode On, banner paper is 
treated as continuous paper, even with the 
paper-release lever in the single sheet position. 
This prevents the printer from advancing too much 
of the banner paper forward when you press the 
LF/FF button.

Parallel I/F (interface) 
transfer rate

Fast, Normal Sets the transfer rate for printing across the 
parallel port. Always select Fast unless you 
receive transfer rate errors.

Setting Options Description
B-12



Loire-PLUS.BK.book  Page 1  Friday, May 2, 2003  2:56 PM
Glossary

banding The horizontal lines that sometimes appear when printing 
graphics. See also MicroWeave.

buffer The portion of the printer’s memory used to store data before 
printing it.

character table A collection of letters, numbers, and symbols that provides you 
with the characters used in a particular language.

characters per inch (cpi) A measure of the size of text characters, sometimes referred to as 
pitch.

CMYK Cyan (blue-green), magenta, yellow, and black. These colored 
inks are used to create the subtractive system array of printed 
colors.

ColorSync Macintosh software that is designed to help you get WYSIWIG 
(what you see is what you get) output. This software prints 
colors as you see them on your screen.

default A value or setting that takes effect when the equipment is 
turned on, reset, or initialized.

dithering A halftoning method in which dots are arranged in an orderly 
pattern. Dithering works best for printing images with solid 
colors, such as charts and graphs. See also halftoning.

dpi Dots per inch. The dpi measures the resolution. See also 
resolution.

driver A software program that sends instructions to a computer 
device to tell it what to do. For example, your printer driver 
accepts print data from your word processing application and 
sends instructions to the printer on how to print this data.
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Error Diffusion This halftoning setting smooths out edges by randomly placing 
dots of varying colors. 

ESC/P Abbreviation for Epson Standard Code for Printers. This 
system of commands gives you control of your printer from 
your computer. It is standard for all EPSON printers and 
supported by most application programs for personal 
computers.

ESC/P 2 The enhanced version of the ESC/P printer command 
language. Commands in this language produce laser-like 
features, such as scalable fonts and enhanced graphics printing.

Finest Detail This printer driver setting automatically makes your printed 
images sharper and clearer. Be aware that this may increase the 
time required for printing.

font A style of type designated by a name.

grayscale A scale of shades of gray from black to white. Grayscale is used 
to represent colors when printing with black ink only.

halftoning A method of using dot patterns to represent an image. 
Halftoning makes it possible to produce varying shades of gray 
using only black dots, or a nearly infinite array of colors using 
only a few colors of dots.

initialization Returns the printer to its defaults (fixed set of conditions). This 
happens every time you turn on or reset the printer.

ink jet A method of printing in which each letter or symbol is formed 
by precisely spraying ink onto paper.

interface The connection between the computer and a peripheral such as 
a printer. Some printers have two interfaces, parallel and serial. 
A parallel interface transmits data one byte, or eight bits, at a 
time. A serial interface transmits data one bit at a time.

ips Inches per second. This scale is used to measure the printing 
speed.
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media Materials upon which data is printed, such as envelopes, plain 
paper, special paper, and transparencies.

MicroWeave Printing technology that produces images in fine increments to 
reduce the possibility of banding. See also banding.

monochrome This means printing with only one color of ink, which is 
generally black ink.

parallel interface See interface.

print queue Print jobs that are sent to the printer while it is busy are stored 
in a waiting line, or print queue, until they can be printed.

print server The computer connected to the printer. It receives the jobs and 
then distributes them to the assigned printer. It also holds extra 
print jobs while the printer is busy. See also print queue.

printable area The area of a page on which the printer can print. It is smaller 
than the physical size of the page due to margins. 

printer driver See driver.

proportional printing Printing in which the width of the character varies from 
character to character. For example, a capital W receives much 
more space than a lowercase i. The result looks more like a 
typeset book than a typewritten draft.

reset To return a printer to its defaults either by sending a command, 
an INIT signal or by turning the printer off and then back on.

resolution The number of dots per inch used to represent an image.

RGB Red, green, and blue. These colors, in phosphors irradiated by 
the computer monitor’s electron gun, are used to create the 
additive array of screen colors.

scalable fonts Fonts that can be enlarged or reduced. Non-scalable fonts are 
called bitmap fonts and can’t change in size.

screen pattern This feature prints shaded areas as they appear on screen, 
instead of printing them as halftones.
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serial interface See interface.

spool The process by which the printer driver converts the print data 
into codes that your printer understands. This data is then sent 
to the printer directly or to the print server.

Spool Manager An EPSON software program that converts print data into 
codes that your printer understands. See also spool.

Status Monitor An EPSON software program that displays the printer’s status, 
such as paper out or the amount of ink remaining before 
printing.

subtractive colors Colors produced by pigments that absorb some colors of light 
and reflect others. See also CMYK.
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Index

A Accessories, EPSON, 6
Adhesive sheets, see Self adhesive 

sheets
Adjust lever, see Thickness lever
Adjusting

cut-off position, 3-29, 3-32
loading position, 3-21
margins, 3-12, 3-15, 3-20
tear-off position, 3-22

Advanced mode, 2-1 to 2-3, 2-6
Advanced settings

custom, 2-4 to 2-13
predefined, 2-1 to 2-4

AGM settings, B-11
Aligning print heads

control panel, 5-8 to 5-9
problems, 6-4
utility, 5-7

Alternate Graphics Mode, see 
AGM settings

Assigning name to printer, 4-15
Auto

CR setting, B-11
I/F wait time setting, B-10
line feed setting, B-11
sheet feeder, see Paper tray
tear-off, 3-16, 3-19, 3-22, B-11

AutoCAD driver, 1
Automatic color adjustment, 2-9
Automatic mode, 1-3, 1-10, 2-6, 

2-9, 3-5

B Background printing
Macintosh, 1-11, 4-7, 4-16, 

6-11, 6-12, 6-17
Windows, 4-1

Banding, 6-4
Banner mode, 3-24, 3-29, 3-32, 

3-33, B-12

Banners
loading roll paper, 3-23 to 3-26
optional paper cutter, 3-23
paper specifications, B-3
printing from Macintosh, 

3-30 to 3-31
printing from Windows, 

3-26 to 3-29
removing roll paper, 

3-32 to 3-33
Blank pages, 6-18
Blurry printouts, 6-6
Brightness setting, 2-9
Built-in sheet feeder, see Paper tray
Buttons, control panel, 1-13, 1-15

C CAD files, A-2
Cancelling

print jobs, 1-7
printer software changes, 1-4, 

1-9
Character tables, B-11
Characters, garbled, 6-17
Cleaning

print heads, 5-1 to 5-3
printer, 5-9
sheets, special media, 3-5 to 3-6

Coarse Dithering setting, 2-6
Collate setting, 1-4
Color

Adjustment modes, 2-9
custom settings, 2-8 to 2-10
problems, 6-4 to 6-7

Colorimetric setting, 2-11
ColorSync, 2-3, 2-8, 2-10 to 2-11
Communication problems, 

6-2 to 6-3
I-1



Index

Loire-PLUS.BK.book  Page 2  Friday, May 2, 2003  2:56 PM
Continuous label paper
loading, 3-16
Media Type setting, 3-4

Continuous paper
page length setting, B-11
printing on, 3-15 to 3-19
removing, 3-19 to 3-20
specifications, B-4 to B-5
switching to single sheets, 3-22

Contrast setting, 2-9
Control codes, B-1
Control panel

buttons, 1-8, 1-13, 1-15
default-setting mode, 

B-8 to B-12
lights, 1-13 to 1-14, 6-8 to 6-10
Media Type setting, 1-3, 1-11, 

2-3
print head alignment, 

5-8 to 5-9
print head cleaning, 5-3
using, 1-13 to 1-15, 6-1 to 6-2, 

6-8 to 6-10
Copies setting, 1-4
Current Settings box, 1-4, 1-11, 

2-4
Custom paper size, 3-23, 3-28, 

3-30
Custom settings

changing, 2-13
color, 2-8 to 2-10
deleting, 2-13
print quality, 2-4 to 2-7
project types, 2-3
refining, 2-13
saving, 2-12
special effects, 2-4 to 2-7

Cut-off position, 3-32
Cyan setting, 2-9

D Default printer options, setting, 
1-5 to 1-6

Default-setting mode, B-8 to B-12
Deleting print job, 4-3
Despooler, 1-7 to 1-8, 4-5
Dithering settings, 2-6

Draft printing, 2-3, 2-6
Driver, help, 1-11 to 1-12

E Economy setting, 2-3, 2-6, 6-6
Electrical specifications, B-6
Empty color ink cartridge, printing 

with, 5-6, 6-6
Emulation, B-10
ENERGY STAR, 6
Energy-saving tips, 6
Envelopes

Media Type setting, 3-4
printing on, 3-4, 3-10, 3-14
specifications, B-3, B-5
thickness lever setting, 3-7, 

3-13
Environmental specifications, B-6
EPSON

accessories, 6
help, 5 to 6
media, 3-4
Monitor3 utility, 4-6 to 4-7
Namer utility, 4-15
Plot!, A-1 to A-4
Preferred Protection Plan, 1-5
Store, 6

Error Diffusion setting, 2-6
ESC/P 2, B-10
Ethernet interface, 2

F Faint printouts, 6-5, 6-7
Fine Dithering setting, 2-6
Finest Detail setting, 2-7
FireWire requirements, 2, 3
Flip Horizontal setting, 6-18
Fonts, B-2, B-10

G Garbled characters, 6-17
Glossy Paper

choosing, 3-3
specifications, B-3

Graph-type projects, settings for, 
2-3
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H Halftoning setting, 2-6
Head Cleaning utility, 5-2
Help

EPSON, 5 to 6
online, 1-11 to 1-12

High Speed setting, 2-7
Horizontal banding, 6-4
Host system, network setup, 4-12
HPGL files, printing, A-1 to A-4

I I/F mode, B-10
IBM XL24E emulation, B-10
ICM (Image Color Matching), 2-3, 

2-8 to 2-10
Improving print quality, 6-3 to 6-6
Incorrect

characters, 6-17
margins, 6-17

Ink
monitoring level, 1-7 to 1-8, 

4-5, 4-8
setting, 1-3, 1-11, 2-6
Status, 1-8

Ink cartridge
printing with empty color, 5-6
problems, 6-5, 6-10
replacing, 5-4 to 5-5
specifications, B-5

Ink jet paper
choosing, 3-3
printing on, 3-4
specifications, B-3

Ink Jet Transparencies
choosing, 3-3
printing on, 3-4
specifications, B-3 to B-4

Interface (I/F) mode, B-11
Interface cards, problems, 6-8
Interface specifications, B-7
International character sets, B-11
Italic character set, B-11

J Jammed paper, 1-13, 6-9, 6-16

L Labels
continuous label paper, 3-4, 

3-16
Media Type setting, 3-4
specifications, B-4
tear-off position, 3-22

Landscape setting, 1-4, 1-9
Lights, control panel, 1-13 to 1-14, 

6-1, 6-8 to 6-10
Line spacing, B-1
Loading position, adjusting, 3-21

M Macintosh
background printing, 1-11, 4-7, 

4-16
ColorSync, 2-3, 2-8, 

2-10 to 2-11
interface specifications, B-7
managing print jobs from, 

4-6 to 4-8
Monitor3, 4-7
network printing, 4-15 to 4-16
online help, 1-12
printing from, 1-9 to 1-11
problems, 6-11 to 6-13, 6-17
system requirements, 1-3

Magenta setting, 2-9
Maintaining printer, 5-1 to 5-9
Managing print jobs

Macintosh, 4-6 to 4-8
Windows, 1-7 to 1-8, 4-1 to 4-6

Manual feeder, 3-12 to 3-15
Margins

adjusting, 3-12, 3-15, 3-20
problems, 6-17
specifications, B-4 to B-5

Mechanical specifications, B-6
Media Check, 1-8
Media Type setting, 1-3, 1-11, 2-3, 

2-6, 3-4
Memory problems, 6-8, 

6-11 to 6-12, 6-17
Messenger service, Windows NT, 

1-8, 4-6
Micro Adjust buttons, 3-20 to 3-22
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MicroWeave setting, 2-7
Mirror images, 6-18
Monitor3 utility, 4-6 to 4-7
Monitoring ink level, 1-7 to 1-8, 

4-5, 4-8
More Settings dialog box, 

2-4 to 2-11
Moving printer, 5-9 to 5-10

N Namer utility, EPSON, 4-15
Network

I/F mode setting, B-11
path, 4-13 to 4-14
port, setting up on Windows 

XP or 2000, 4-9 to 4-10
Network printing

Macintosh, 4-15 to 4-16
problems, 6-6
Windows, 4-9 to 4-14

New Hardware Found window, 
6-10

No Halftoning setting, 2-6
Nozzle Check

pattern, 5-4, 6-3
utility, 5-2 to 5-4

O Online driver help, 1-11 to 1-12
Orientation setting, 1-4, 1-9

P Page length setting, B-11
Page Setup dialog box, 1-9
Paper

coated, 3-1
handling problems, 

6-13 to 6-16
jams, 1-13, 6-16
loading guidelines, 3-4 to 3-6
menu, 1-4, 1-9
monitoring amount, 1-7 to 1-8
plain, 3-1
specifications, B-3 to B-5
tray, 3-7 to 3-12

Paper size, custom, 3-23

Paper Status, 1-8
Paper-release lever, 1-13, 3-16, 

3-21, 3-23, 3-24, 3-33
Parallel cable requirements, 1-3
Parallel I/F transfer rate setting, 

6-17, B-12
Pen colors, A-2
Perceptual setting, 2-11
Photo paper

printing on, 3-11
Photo Quality Banner Paper

loading, 3-23 to 3-26
optional paper cutter, 3-23
printing on, 3-26 to 3-31
removing, 3-32 to 3-33

Photo Quality Ink Jet Paper
choosing, 3-3
printing on, 3-4
specifications, B-3

Photo Quality Self Adhesive Sheets
choosing, 3-3
printing on, 3-4
specifications, B-3

Photo setting, 2-3
Photo-realistic color adjustment, 

2-9
Pitch setting, B-10
Plotter files, A-1 to A-4
Portrait setting, 1-4, 1-9
Predefined advanced settings, 

2-1 to 2-4
Print direction setting, B-10
Print head alignment

control panel, 5-8 to 5-9
utility, 5-7, 6-4

Print job, deleting, 4-3
Print quality problems, 6-3 to 6-6
Print Quality setting, 2-6
Print queue, 4-2
Printable area, 1-4, B-4 to B-5
Printer

cleaning, 5-9
stand, 8
test, 6-2 to 6-3
transporting, 5-9 to 5-10
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Printer driver, accessing
Control Panel, 1-5 to 1-6
Macintosh applications, 1-9
Windows applications, 1-2

Printer software, using, 
1-11 to 1-12

Printer status
Macintosh, 4-6 to 4-8
Windows, 1-7 to 1-8, 4-4 to 4-5

Problems
communication, 6-2 to 6-3
diagnosing, 6-1 to 6-2
paper handling, 6-13 to 6-16
print quality, 6-3 to 6-6
printing, 6-7 to 6-13
solving, 6-1 to 6-18
unexpected printout results, 

6-17 to 6-18

Q Quality/Speed slider, 1-3, 1-11, 2-2

R Remote systems, network setup, 
4-13

Removing driver, 6-13
Rendering Intent setting, 2-11
Replacing ink cartridges, 

5-4 to 5-5, 6-5, 6-10
Resolution, 2-6, B-1
Reverse order setting, 1-4
Roll paper

loading, 3-24 to 3-26
printing on, 3-26 to 3-33
specifications, B-3

S Safety
approvals, B-7
instructions, 7 to 9

Saturation setting, 2-9, 2-11
Self adhesive sheets

choosing, 3-3
loading, 3-4
Media Type setting, 3-4
specifications, B-3

Self test, 6-2 to 6-3
Service, 5 to 6
Sheet feeder, see Manual feeder, 

Paper tray
Single sheets

printing on, 3-4, 3-6 to 3-15
switching to continuous paper, 

3-22
Skip over perforation setting, B-11
Slashed zero, B-8, B-11
Smeared printouts, 6-6
Special effects settings, 2-4 to 2-7
Specifications

electrical, B-6
environmental, B-6
ink cartridge, B-5
interface, B-7
mechanical, B-6
paper, B-3 to B-5
printing, B-1 to B-2

Spool directory, 4-3
Spool Manager

problems, 6-8, 6-11, 6-17
using, 4-2 to 4-3

Status Monitor
Macintosh, 4-8
problems, 6-1, 6-11
Windows, 1-8, 4-4 to 4-5

Support, EPSON, 5 to 6
System requirements

Macintosh, 3
Windows, 2

T TCP/IP, 4-10
Tear-off position

adjusting, 3-20, 3-22
for labels, 3-22

Technical specifications, 
B-1 to B-7

Technical support, 5 to 6
Temporary print job files, 4-2
Testing printer, 6-2 to 6-3
Text/Graph setting, 2-3
Thickness lever, 3-7, 3-13, 6-3
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Transparencies
choosing, 3-3
printing on, 3-4
specifications, B-3 to B-4

Transporting printer, 5-9 to 5-10
Troubleshooting, 6-1 to 6-18

U Unit ID number, 5
USB requirements, 3
User Defined paper size, 3-28
Utilities

EPSON Monitor3, 4-6 to 4-7
EPSON Namer, 4-15
Head Cleaning, 5-2
Nozzle Check, 5-2 to 5-4
Print Head Alignment, 5-7
Status Monitor, see Status 

Monitor

V Vertical banding, 6-4
Vertical lines, misaligned, 2-7, 

5-7 to 5-9, 6-4
see also Print Head Alignment

Video/Digital Camera setting, 2-3, 
2-10

Vivid color adjustment, 2-9
Voltage, B-6

W What’s This prompt, 1-2, 1-12
Windows

checking printer status, 
1-7 to 1-8

ICM, 2-8 to 2-10
managing print jobs from, 

4-1 to 4-6
network printing, 4-9 to 4-14
online help, 1-11 to 1-12
printing from, 1-1 to 1-5
problems, 6-10 to 6-11
setting default printer options, 

1-5 to 1-6
Spool Manager, 4-2 to 4-3
system requirements, 2 to 3

Windows NT
checking printer status, 1-8
network printing, 4-9 to 4-11
online help, 1-12
setting default printer options, 

1-6

X XL24E emulation, IBM, B-10

Y Yellow setting, 2-9

Z Zero setting, B-11
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